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Preface

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco 
also provides several ways to obtain technical assistance and other technical 
resources. These sections explain how to obtain technical information from Cisco 
Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
Cisco documentation and additional literature are available in the Product 
Documentation DVD package, which may have shipped with your product. The 
Product Documentation DVD is updated regularly and may be more current than 
printed documentation.

http://www.cisco.com/techsupport
http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
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The Product Documentation DVD is a comprehensive library of technical product 
documentation on portable media. The DVD enables you to access multiple 
versions of hardware and software installation, configuration, and command 
guides for Cisco products and to view technical documentation in HTML. With 
the DVD, you have access to the same documentation that is found on the Cisco 
website without being connected to the Internet. Certain products also have .pdf 
versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. 
Registered Cisco.com users (Cisco direct customers) can order a Product 
Documentation DVD (product number “DOC-DOCDVD=”) from Cisco 
Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation
Beginning June 30, 2005, registered Cisco.com users may order Cisco 
documentation at the Product Documentation Store in the Cisco Marketplace at 
this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. 
to 5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States 
and Canada, or elsewhere by calling 011 408 519-5055. You can also order 
documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 
1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 
519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by 
completing the online feedback form that appears with the technical documents 
on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

http://www.cisco.com/go/marketplace/
http://www.cisco.com/go/marketplace/
mailto:tech-doc-store-mkpl@external.cisco.com
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You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at 
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you 
can access a Product Security Incident Response Team Really Simple Syndication 
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
http://www.cisco.com/go/psirt
http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
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Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you 
think that you might have identified a vulnerability in a Cisco product, contact 
PSIRT:

• Emergencies— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack 
or a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.

• Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to 
encrypt any sensitive information that you send to Cisco. PSIRT can work from 
encrypted information that is compatible with PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use 
in your correspondence with PSIRT is the one linked in the Contact Summary 
section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical 
assistance. The Cisco Technical Support & Documentation website on Cisco.com 
features extensive online support resources. In addition, if you have a valid Cisco 

mailto:security-alert@cisco.com
mailto:psirt@cisco.com
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
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service contract, Cisco Technical Assistance Center (TAC) engineers provide 
telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online 
documents and tools for troubleshooting and resolving technical issues with Cisco 
products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website 
requires a Cisco.com user ID and password. If you have a valid service contract 
but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial 
number before submitting a web or phone request for service. You can access the 
CPI tool from the Cisco Technical Support & Documentation website by clicking 
the Tools & Resources link under Documentation & Tools. Choose Cisco 
Product Identification Tool from the Alphabetical Index drop-down list, or click 
the Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree view; or for 
certain products, by copying and pasting show command output. Search results 
show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the 
information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 

http://www.cisco.com/techsupport
http://tools.cisco.com/RPF/register/register.do
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solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco engineer. The TAC Service Request Tool is 
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco engineers are assigned 
immediately to S1 and S2 service requests to help keep your business operations 
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

http://www.cisco.com/techsupport/servicerequest
http://www.cisco.com/techsupport/contacts
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Obtaining Additional Publications and 
Information

Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to 
help growing companies learn how they can use technology to increase 
revenue, streamline their business, and expand services. The publication 
identifies the challenges facing these companies and the technologies to help 
solve them, using real-world case studies and business strategies to help 
readers make sound technology investment decisions. You can access iQ 
Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

http://www.cisco.com/go/marketplace/
http://www.ciscopress.com
http://www.cisco.com/packet
http://www.cisco.com/go/iqmagazine
http://ciscoiq.texterity.com/ciscoiq/sample/
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• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support 
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for 
networking professionals to share questions, suggestions, and information 
about networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html

http://www.cisco.com/ipj
http://www.cisco.com/en/US/products/index.html
http://www.cisco.com/discuss/networking
http://www.cisco.com/en/US/learning/index.html
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1
Planning Your Installation

The Cisco Virtual Network Data Server solution enables you to create an accurate 
highly detailed model of your current network based on configuration, topology, 
and traffic information. 

Installation Workflows
There are two possible workflows for installing Cisco VNDS, depending on your 
situation:

• First-Time Installation, page 1-1—Use this workflow to install Cisco VNDS 
for the first time.

• Update Installation, page 1-2—Use this workflow to update a previous 
version of Cisco VNDS to the current version.

First-Time Installation
You should perform a first-time installation only if no prior version of 
Cisco VNDS is installed on your computer. Table 1-1 lists the phases of the 
installation process.

Note Cisco recommends that you do the steps in the order listed in this table.
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Update Installation
You should perform an update installation if a prior version of Cisco VNDS exists 
on your computer and you want to update it to the current version.

Warning When updating from an earlier Cisco Virtual Network Data Server release, 
you must configure the Oracle database by running the setup_accounts 
script (@setup_accounts.sql). This means that you must re-create the 
network database. Network models created by previous releases cannot be 
retained by this release. 

Note Cisco recommends that you perform the steps in the order listed in Table 1-2.

Table 1-1 First-Time Installation: Workflow

Description Reference
Step 1 Register your Cisco Solution product Registering Your Cisco Solution Product, 

page 1-3

Step 2 Determine the host computers Determining Installation Options, page 1-4

Step 3 Determine licensing options Product Licensing, page 1-5

Step 4 Verify system requirements System Requirements, page 2-1

Step 5 Install Cisco Virtual Network Data Server Installing Cisco Virtual Network Data Server 
(Windows), page 3-1

Installing Cisco Virtual Network Data Server 
(Linux), page 4-1

Step 6 Add a Virtual Network Data Server license Adding a License, page 5-3
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    Upgrading Licenses

Upgrading Licenses
If you have a Restricted license and want to upgrade it to an Unrestricted license, 
refer to the “Upgrading a License” section on page 5-4.

Registering Your Cisco Solution Product
Before you can install Cisco VNDS, you must register your product with Cisco 
Systems, Inc. After you register your product, Cisco will send you a username, 
password, and group ID number. You will need this information when you install 
your product licenses (as described in the “Adding a License” section on 
page 5-3.)

Note By accessing or using the Cisco Systems, Inc. products in this package, you agree 
that your use of such products is governed by the terms and conditions of the 
Cisco Systems, Inc. Software License and any applicable supplemental license 
agreement.

To review the terms of the Software License before accessing or using the 
products, you can find a copy of the Cisco Software License in the Cisco 
Information Packet that accompanies the products below or online at:

Table 1-2 Update Installation: Workflow

Description Reference
Step 1 Verify system requirements System Requirements, page 2-1

Step 2 Install the current release of VNDS Installing Cisco Virtual Network Data Server 
(Windows), page 3-1

Installing Cisco Virtual Network Data Server 
(Linux), page 4-1

Step 3 Refresh licenses Refreshing a License, page 5-7

Step 4 Remove the previous VNDS installation 
(optional)

Uninstalling 
Cisco Virtual Network Data Server, page 6-1
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http://www.cisco.com/univercd/cc/td/doc/es_inpck/cetrans.htm

To obtain the license activation credentials, log on to one of the websites listed 
below and follow the registration instructions. The Product Authorization Key 
(PAK) attached to your Software License Claim Certificate is required for the 
registration process. After registering, retain your Claim Certificate for future 
reference.

Registration Information
Use this URL if you are a registered user of Cisco.com:

http://www.cisco.com/go/license

Use this URL if you are not a registered user of Cisco.com:

http://www.cisco.com/go/license/public

You should receive the activation credentials and additional installation 
instructions through e-mail within one hour of registration. If you experience 
problems with the registration websites or if you have additional questions, 
contact the Cisco Licensing department through e-mail at licensing@cisco.com, 
or open a service request over the telephone by using one of these numbers:

• Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)

• EMEA: +32 2 704 55 55

• USA: 1 800 553-2447

You can find a complete list of Cisco TAC contacts at this URL:

http://www.cisco.com/techsupport/contacts

Determining Installation Options
Before installing Cisco Virtual Network Data Server, select the computers where 
you want to install the software. The host computer must meet the system 
requirements described in the System Requirements chapter.

After you complete this step, return to the “Installation Workflows” section on 
page 1-1.

http://www.cisco.com/univercd/cc/td/doc/es_inpck/cetrans.htm
http://www.cisco.com/go/license/public
http://www.cisco.com/go/license
http://www.cisco.com/techsupport/contacts
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Product Licensing
Cisco VNDS requires a corresponding license to be installed and available to that 
program. On startup, the program contacts a License Server and requests a 
license; if it does not obtain a license, the program does not start. The License 
Server is a daemon/process that runs on the host where a license is installed; it 
handles license requests from component programs.

After you determine the licensing configuration you want, return to the 
“Installation Workflows” section on page 1-1.

Restricted and Unrestricted Licenses
You can buy either Restricted or Unrestricted versions of the Cisco VNDS 
program licenses. This distinction determines the scope of authorized users:

• A Restricted license confines the user of a program to one IP network by 
default subnet class. This means that the licensed program can be used only 
if the License Server is in the same classful IP network. IP network 
connectivity between the program and server is required.

• An Unrestricted license offers the most flexibility for organizations that 
operate multiple IP networks (as defined by default subnet class). Users can 
access licenses from within the same classful IP network as the License 
Server as well as from up to 100 additional IP networks. These networks must 
be defined in advance.

Selecting the License Type
When you install a component program, the installer asks you to specify the 
licensing mode. The options are:

• Floating/Local (“Floating: serve licenses from this computer”)—If you select 
this option, the program will request a license from a License Server running 
on the local computer.

• Floating/Remote (“Floating: access licenses from remote server”)—If you 
select this option, the program will request a license from a License Server 
running on a remote computer. (The installer also prompts you for the host 
name of the remote server.)
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Floating mode enables multiple users to share a license for Design and 
Analysis. The following section describes Floating mode in more detail.

Floating Mode
Floating mode enables multiple users to share a license for VNDS. On startup, the 
program communicates with the License Server automatically and “checks out” a 
license. When the program closes, it returns the license to the License Server. 
Then the license is available for another VNDS user to start the program and 
check out the license. In Floating mode, the license is not “node-locked,” but can 
“float” to different computers.

Note Multiple users cannot share the same VNDS license concurrently. Multiple 
concurrent VNDS sessions require an equivalent number of program licenses. 

Although the VNDS license server must use Floating mode, its license is not 
shared among multiple users. The Cisco Virtual Network Data Server operates 
automatically, “consuming” its license continually. System administrators do not 
need a license to log in to and operate the system. 
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How Licensing Types and Modes Affect Who Can Use a 
License

Table 1-3 illustrates how the different license modes and restriction types 
determine which applications can use a specific license.

Licensing Requirements
Note the following requirements:

• You must add the corresponding license as described in the “Adding a 
License” section on page 5-3. Installing a program and specifying the 
licensing options does not install the license itself. 

• If you specify Floating (remote) licensing for a program, the specified 
License Server must be accessible (via a TCP/IP network) to that program, as 
described in the “Restricted and Unrestricted Licenses” section on page 1-5.

Table 1-3 Licensing Types and Modes

License 
Mode Used 
by Installed 
Program

Restriction 
Type of 
Installed 
License

Client Applications That Can Use the License on the License 
Server

Applications on the 
Same Host as the 
License Server

Applications in the 
Same Classful IP1 
Network as the License 
Server

1. Classful IP network refers to the classic “A”, “B”, and “C” IP network classes. For example, if the License Server is installed 
on a workstation that has a class “B” IP network address, then all workstations with the same class “B” address as the License 
Server are considered to be on the same classful IP network as the License Server.

Applications in a 
Different Classful IP 
Network from the 
License Server

Floating Restricted Yes Yes No

Floating Unrestricted Yes Yes Yes
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Licensing Scenarios: Examples
This section shows some examples of how you can install and configure licenses 
in your network. 

In Table 1-4, all licenses are installed on one host (VNDS_client), which acts as 
the only License Server in the network. The local Cisco VNDS program uses 
Floating/Local mode, while the remote programs use Floating/Remote mode. This 
type of setup is recommended; because there is only one License Server, it is 
easier to manage your licenses and configure programs. 

Table 1-4 Licensing Example 1

LOCAL HOST CONFIGURATION

LICENSING OPTION 
SETTINGS FOR 
INSTALLED 
PROGRAM

Installed Program Host Name Licenses Installed on Host
License 
Server

License 
Mode

Cisco Audit and Analysis AA_client_1 — VNDS_client Floating / 
Remote

Cisco Audit and Analysis AA_client_2 — VNDS_client Floating / 
Remote

Cisco VNDS VNDS_client
(License 
Server)

Cisco VNDS
Cisco Audit and Analysis

(local host) Floating / 
Local



1-9
Installation Guide for Cisco Virtual Network Data Server

OL-11599-01

Chapter 1       Planning Your Installation
    Product Licensing

In Table 1-5, the Cisco Audit and Analysis program is installed on AA_client_1 
and two other hosts. Each installation requests a license from AA_client_1. (Keep 
in mind that if only one license is installed on the host, only one 
Cisco Audit and Analysis session can run at a time.) The two other programs are 
installed on separate hosts which also act as License Servers.

Table 1-5 Licensing Example 2

LOCAL HOST CONFIGURATION

LICENSING OPTION 
SETTINGS FOR 
INSTALLED 
PROGRAM

Installed Program Host Name Licenses Installed on Host
License 
Server

License 
Mode

Cisco Audit and Analysis AA_client_1 
(License Server)

Cisco Audit and Analysis (local host) Floating / 
Local

Cisco Audit and Analysis AA_client_2 — AA_client Floating / 
Remote

Cisco Audit and Analysis AA_client_3 — AA_client Floating / 
Remote

Cisco VNDS VNDS_client
(License Server)

Cisco VNDS (local host) Floating / 
Local
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In Table 1-6, the programs are installed on separate hosts with their respective 
licenses. Cisco Audit and Analysis uses Standalone mode, while Cisco VNDS 
request licenses from local License Servers.

In Table 1-7, each program has its license installed on the same computer and uses 
Floating/Local mode.

Table 1-6 Licensing Example 3

LOCAL HOST CONFIGURATION

LICENSING OPTION 
SETTINGS FOR 
INSTALLED 
PROGRAM

Installed Program Host Name Licenses Installed on Host
License 
Server

License 
Mode

Cisco Audit and Analysis AA_client_1 Cisco Audit and Analysis (local 
host)

Standalone

Cisco VNDS VNDS_client
(License Server)

Cisco VNDS (local 
host) 

Floating / 
Local

Table 1-7 Licensing Example 4

LOCAL HOST CONFIGURATION

LICENSING OPTION 
SETTINGS FOR 
INSTALLED 
PROGRAM

Installed Program Host Name Licenses Installed on Host
License 
Server

License 
Mode

Cisco Audit and Analysis

Cisco VNDS

CAS_client
(License Server)

Cisco Audit and Analysis

Cisco VNDS

(local host)

(local host)

Floating 
/ Local
Floating 
/ Local
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2
System Requirements

This chapter describes the system requirements for the individual components in 
Cisco Virtual Network Data Server. Cisco recommends that, before you start to 
install Cisco VNDS, you verify that your computer hardware and software meet 
the requirements outlined in this chapter. 

Cisco Virtual Network Data Server: System 
Requirements

Supported Platforms

Vendor1 2

1. Cisco VNDS is supported on the English-language version of each operating system.

Series

Microsoft Windows 2000 Server

Windows 2000 Professional

Windows XP Professional

Windows Server 2003

Red Hat Red Hat Enterprise Linux 3 (v2.4 Kernel)3

Red Hat Enterprise Linux 4 (v2.6 Kernel)
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Required System Patches

To determine the service pack installed on your Windows system, run 
winver.exe:

Step 1 Select Run from the Windows Start menu.

Step 2 Type in the command winver and click OK. The About Windows window appears 
and shows the version and service pack level installed.

2. Cisco VNDS is not supported on 64-bit editions of Windows or Linux operating systems, nor on 
Windows 2003 Web Edition.

3. libstdc++.so.6 is required with Red Hat Enterprise Linux 3. You can obtain this by installing gcc 
3.4 or higher.

Vendor OS Patch Number/Name

Microsoft Windows 2000 Server Service Pack 2 minimum

Windows 2000 Professional Service Pack 2 minimum

Windows XP Professional N/A

Windows Server 2003 N/A
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Windows and Red Hat System Configuration
Cisco VNDS does not operate on machines with the Intel Itanium processor. To 
check the processor used by your Windows computer, right-click on the My 
Computer desktop icon and choose Properties.

Other Requirements
Cisco VNDS requires a dedicated Oracle database installation and dedicated 
database instance that cannot be shared with other applications. The preferred 
configuration includes a dedicated Oracle database installation local to the system 
on which Cisco VNDS is installed.

A shared Oracle instance where applications other than Cisco VNDS share/access 
the database or database instance are NOT supported. An Oracle database that is 
running on a system physically remote from or on a separate LAN from the 
Cisco VNDS system is NOT supported. 

Processor1

1. A dual-processor configuration is recommended if Cisco VNDS and the back-end Oracle database are to reside on the same 
platform.

RAM2

2. Cisco VNDS performance will improve with more available memory as network size increases.

Disk FSB3

3. Front-Side Bus (FSB) speed affects the speed of data transfer to and from the Cisco VNDS database; faster bus speeds will 
improve Cisco VNDS performance.

Minimum

Intel Pentium D processor model 945
2x2MB Cache, 3.4 GHz

4 GB 80 GB 800 MHz

 Dual Processor, Dual Core Intel Xeon Model 5060, 
2x2MB Cache,3.2 GHz

4 GB  80 GB 1066 MHz

Recommended

 Intel Core2 Duo Processor Model E6700, 4MB 
Cache - 2.66GHz

6 GB 80GB 1066 MHz

 Dual Processor, Dual Core Intel Xeon Model 5160, 
4MB Cache - 3.0 GHz

6 GB 160GB 1333 MHz
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Software1

1. Contact Oracle Corporation for information about Oracle 9i system requirements. 

Platform  Supported Version 
Required Database 
Character Set2

2. The supported national character set is: AL16UTF16. For international customers: The Virtual Network Data Server 4.0 
product might not operate correctly when used with Oracle databases that have been configured with international, or Unicode 
(AL32UTF8), database character sets.

Oracle Database Windows • Oracle 9i Release 2 (version 9.2.0.1 or 
higher)

• Oracle 10g Release 2 (version 10.2.0.1 or 
higher) 

WE8MSWIN1252

Red Hat •  Oracle 9i Release 2 (version 9.2.0.1 or 
higher) or

• Oracle 10g Release 2 (version 10.2.0.1 or 
higher)

 WE8ISO8859P1
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3
Installing 
Cisco Virtual Network Data Server 
(Windows) 

This chapter describes how to install the Cisco Virtual Network Data Server 
program on Windows. 

System Requirements 

Note The host for Cisco Virtual Network Data Server must meet minimum system 
requirements. If the host system does not meet minimum requirements, do not 
install Cisco VNDS. For more information, see 
Cisco Virtual Network Data Server: System Requirements, page 2-1.

If the host system does not have an Oracle database or an Oracle client 
installation, but meets all other requirements, install Oracle before installing 
Cisco Virtual Network Data Server as described in the Installation Workflows for 
your installation scenario. 

3
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Installation Workflows
This section covers the various installation scenarios you may encounter with 
Cisco VNDS on Windows. The procedures you must follow depend upon whether 
this is an initial installation or an update to an existing installation of the 
Cisco Virtual Network Data Server program. The procedures to follow also 
depend upon whether Cisco VNDS uses a local (same host) or a remote (different 
host) database. 

Select the installation workflow appropriate for your circumstances. Follow the 
procedures in your workflow to install Cisco Virtual Network Data Server. 

• Initial Cisco VNDS Installation (Windows/Local Oracle Database), page 3-2

• Initial Cisco VNDS Installation (Windows/Remote Oracle Database), 
page 3-3

• Update Cisco VNDS Installation (Windows), page 3-5

Note Cisco VNDS software is installed in HTTP mode by default. After successful 
installation and verification of the Cisco Virtual Network Data Server software, 
HTTPS may be configured. See the HTTPS Mode section of Release Notes for 
more information.

Initial Cisco VNDS Installation (Windows/Local Oracle 
Database)

If you are installing Cisco Virtual Network Data Server for the first time and will 
install Oracle on the same host, follow this workflow:

Step 1 Install the Oracle database on the Cisco VNDS host.

• Oracle9i users: see Installing the Oracle9i Database (Windows), page A-1. 

• Oracle10g users: see Installing the Oracle10g Database (Windows), 
page A-7. 

Step 2 Collect Oracle database information. 

See the “Collecting Oracle Database Access Information (Windows)” procedure 
on page A-13.
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Step 3 Install Oracle TopLink.

See the “Installing Oracle TopLink (Windows)” procedure on page A-14.

Note You must complete the previous steps before you install Virtual Network 
Data Server.

Step 4 Install the Cisco Virtual Network Data Server program. 

See the “Installing Cisco VNDS (Windows)” procedure on page 3-6.

Step 5 Configure the Oracle database.

See the “Configuring the Oracle Database for Cisco VNDS (Windows)” 
procedure on page 3-17. 

Step 6 Verify the Oracle configuration. 

See the “Verifying the Oracle Configuration for Cisco VNDS (Windows)” 
procedure on page 3-21). 

Step 7 Verify the Cisco VNDS software installation.

See the “Verifying the VNDS Software Installation (Windows)” procedure on 
page 3-23.

Initial Cisco VNDS Installation (Windows/Remote Oracle 
Database)

If you are installing Cisco Virtual Network Data Server for the first time and will 
install Oracle on a different host, follow this workflow:

Step 1 Install the Oracle database on the remote host. 

For information about installing the Oracle database, see Appendix A, “Oracle 
Procedures (Windows)” or Appendix B, “Oracle Procedures (Linux)”.

Step 2 Install the Oracle client on the Cisco VNDS host.
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Note Install the version of the client that matches the version of the database 
that you installed in step 1.

• Oracle9i users: see Installing the Oracle9i Client (Windows), page A-5. 

• Oracle10g users: see Installing the Oracle 10g Client (Windows), page A-10. 

Step 3 Collect Oracle database information (use the procedure for the platform on which 
the remote database is installed):

• “Collecting Oracle Database Access Information (Windows)” procedure on 
page A-13 

• “Collecting Oracle Database Access Information (Linux)” procedure on 
page B-3

Step 4 Install Oracle TopLink.

See the “Installing Oracle TopLink (Windows)” procedure on page A-14.

Note You must complete the previous steps before you install Virtual Network 
Data Server.

Step 5 Install the Cisco Virtual Network Data Server program.

See the “Installing Cisco VNDS (Windows)” procedure on page 3-6.

Step 6 Configure the Oracle database on the database host.

See the “Configuring the Oracle Database for Cisco VNDS (Windows)” 
procedure on page 3-17.

Step 7 Verify the Oracle configuration on the Cisco VNDS host. 

See the “Verifying the Oracle Configuration for Cisco VNDS (Windows)” 
procedure on page 3-21.

Step 8 Verify the Cisco VNDS software installation.

See the “Verifying the VNDS Software Installation (Windows)” procedure on 
page 3-23.
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Update Cisco VNDS Installation (Windows)
If you are updating a previous Cisco Virtual Network Data Server program 
installation, follow this workflow.

Warning When updating from an earlier Cisco Virtual Network Data Server release, 
you must configure the Oracle database by running the setup_accounts 
script (@setup_accounts.sql). This means that you must re-create the 
network database. Network models created by previous releases cannot be 
retained by this release. 

Step 1 Collect Oracle database information. 

See the “Collecting Oracle Database Access Information (Windows)” procedure 
on page A-13.

Note You must complete this step before you install Virtual Network Data 
Server.

Step 2 Install the Cisco Virtual Network Data Server program.

See the “Installing Cisco VNDS (Windows)” procedure on page 3-6.

Step 3 Configure the Oracle database on the database host.

See the “Configuring the Oracle Database for Cisco VNDS (Windows)” 
procedure on page 3-17.

Step 4 Verify the Oracle configuration on the Cisco VNDS host. 

See the “Verifying the Oracle Configuration for Cisco VNDS (Windows)” 
procedure on page 3-21.

Step 5 Verify the Cisco VNDS software installation. 

See the “Verifying the VNDS Software Installation (Windows)” procedure on 
page 3-23.
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Note When updating from a previous Cisco VNDS installation, you can 
migrate configuration settings. Do not uninstall the previous installation 
until you migrate product configuration settings to the new installation. 
Make sure you read important notes on product migration in the Release 
Notes.

Installing Cisco VNDS (Windows)
Use the following procedure to install the Cisco Virtual Network Data Server 
program.

Installing Cisco VNDS (Windows)

Step 1 Log into the host as Administrator or as a user with full administrative privileges. 
If you are not logged in with the proper privileges, log off and then log on with an 
appropriate account. 

Step 2 If the Cisco VNDS program is already installed on the host and you are updating 
to a new release, perform the following steps before continuing. 

a. Stop Cisco VNDS operation: Select Services > Stop Services from the 
Cisco Virtual Network Data Server Control Panel. 

b. Exit Cisco VNDS: Select File > Exit from the Control Panel menu bar. 

c. Open the Windows Task Manager, and select the Processes tab. If an 
op_monitor process is running, stop the process. 

d. Use a License Manager to see if your Cisco VNDS license is still held. If the 
license is still held by Cisco VNDS, use the License Manager to revoke the 
license. 

Note Do not rename or uninstall the existing Cisco VNDS release. If 
Cisco VNDS 3.5 is already installed (as part of CAS, CAS-SP, NPS, or 
NPS-SP), you can migrate configuration settings to Cisco VNDS 4.0. 
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Step 3 Start the installer:

a. Insert the Cisco Virtual Network Data Server installation CD into the CD 
drive of the host. If the installer does not start automatically, use Start > Run 
to execute the cvnds-2.0-win-K9.exe program on the CD. 

The installer displays an Introduction panel. 

b. Click Next. 

If an existing Cisco VNDS software installation is detected, a Notice dialog 
appears to remind you to stop services and exit Cisco VNDS. Click Yes to 
continue or No to cancel the installation. 

Step 4 Determine your Oracle installation scenario in Table 3-1 on page 3-8 and follow 
instructions for that scenario.

Note Cisco VNDS can operate with either a local or remote Oracle database. If 
a database is present on the local host, you can use this database; you can 
also use a remote database on a different host. In either case, the installer 
displays a panel that requests database access information. If a local 
database is not found, but an Oracle client installation is detected, the 
installer displays a panel requesting access information about the remote 
database. 
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Note If you are working with a local database, use step 5. If you are working 
with a remote database, use step 6.

Step 5 Specify values for the account Cisco VNDS will use to access the local Oracle 
database: 

– Local Database TNS Service Name

– Local Database User Name

Table 3-1 Oracle Installation Scenarios

Scenario Oracle Installation Instructions

1 • An Oracle installation is not present on 
the host.

• A message box indicates that Oracle 
cannot be found.

• Abort installation. Click OK to cancel 
the installation.

• Install Oracle on the host before 
attempting to install Cisco VNDS.

2 • Oracle database installation is present 
on host.

• If more than one Oracle installation is 
found on the host, the installer asks 
which Oracle you want to use. Select the 
radio button for the correct Oracle 
installation and click Next.

An installer panel appears and asks if you 
want Cisco VNDS to use the local database. 

• Select Yes to use the local database and 
continue with step 5.

• Select No to use a remote database, and 
continue with step 6.

3 • Oracle client installation is present on 
the host.

• If more than one Oracle installation is 
found on the host, the installer asks you 
which Oracle you want to use. Select the 
radio button for the correct Oracle 
installation and click Next.

• An installer panel appears stating that a 
local Oracle client is detected1.

• if the Oracle installation is a Client, 
select the Client radio button. Click OK 
and continue with step 6.

• If the Oracle installation is really a local 
database server, select the Server radio 
button. Enter the Database SID from 
Table A-1 on page A-14. Click OK and 
continue with step 5.

1. Depending upon how Oracle is installed and databases are created, what appears to be a Client installation may really be a 
Server.
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– Local Database Password

– Confirm Password

Note Select a user name that is dedicated for use by Cisco VNDS. DO NOT 
use SYS or SYSTEM for the Local Database User Name. 

Fill in each field with the information collected in Table A-1 on page A-14 
and click Next. Jump to step 7.

Step 6 Specify remote database access information. 

a. The installer prompts you for the following database access information: 

– Remote Database TNS Service Name

– Remote Database SID

– Remote Database Hostname

– Remote Oracle Home Directory

– Remote Oracle Oradata Parent Directory

Fill in each field with the information collected in Table A-1 on page A-14 
and click Next. 

The installer prompts you for additional remote database access information.

b. Specify values for the account Cisco VNDS will use to access the Oracle 
database.

– Remote Database User Name

– Remote Database Password

– Confirm Password

Note Select a username that is dedicated for use by Cisco VNDS. DO NOT 
use SYS or SYSTEM for the Local Database User Name.

c. Fill in each field with the information collected in Table A-1 on page A-14 
and click Next. 

Step 7 The installer prompts you for the location of Oracle Toplink files required by 
Cisco VNDS. 
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Note Note: Version 9.0.3.5 of Oracle Toplink is required. 

a. If you have Toplink installed to the default path within your existing Oracle 
installation, the default path shown in this panel is the correct path. Locate 
the path on your system that contains the following Toplink files: 
tl_core.jar tl_tools.jar tl_x.jar

b. Click Choose and browse to the directory of the required Oracle Toplink files. 
Click Select to complete your choice. 

Step 8 Click Next. If the required files are not found at the selected path, an error dialog 
appears. Click one of the following:

• OK to try again to select a path. 

• Cancel to cancel the installation.

Step 9 Specify the licensing scheme. 

a. The installer prompts you for the type of licensing to use. The Select 
Licensing Type panel provides a choice between remote and local licensing:

– Access licenses from a remote server 

– Serve licenses from a license server on this computer 

Note Selecting the local option results in a license server being installed 
with the VNDS installation. This license server installed is the same 
version license server as is installed with other Cisco Solution 
programs. 

Note The specified license server must have a valid VNDS license before 
you can run the software.

b. Choose the licensing type, then click Next. 

– If you selected remote licensing, the installer displays the Enter Server 
Name and Port panel. Proceed to step c.

– If you selected local licensing the Enter Port panel displays. Jump to step 
d. 
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c. The installer prompts you for the server name and port. 

– Type the hostname of the remote license server in the Server field. 

– Type the port (port_a, port_b, or port_c) used by the remote license 
server in the Port field. 

– Click Next.

The installer prompts you for an installation path. Proceed to step 10.

d. The installer prompts you for the port used by the local license server 
(port_a, port_b, or port_c).

Accept the default value. Click Next to proceed.

The installer prompts you for an installation path. Proceed to step 10.

Note If you are installing on Windows XP, you might see an error window 
that reads “OPNET <product_name> has encountered a problem and 
needs to close.” This error occurs because the installer caused an 
existing license server process (op_license_server.exe) to 
terminate abnormally. This is a known issue; click Don’t Send and 
proceed with the installation.

Note Write down the license settings you have chosen for future reference. 

Step 10 Specify the VNDS installation directory. 

a. Type an installation path in the panel’s path field or use the file browser to 
select an installation path. The path you choose cannot contain embedded 
spaces. 

Note The path you enter is the parent directory for the installation. The 
installer adds \VNDServer\<version>_<build#> to the path you 
choose. 

b. Click Next. 

The installer prompts you for the path to use for the VNDS temp directory. 
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Step 11 Specify the VNDS temporary directory. 

a. Type a temp directory path in the panel’s path field or use the file browser to 
select a path. The path you choose cannot contain embedded spaces.

Note The temp directory holds temporary working files for the product. 
The path you specify is the full path to this directory. 

b. Click Next. 

The installer prompts you for the path to use for the VNDS config file archive 
directory. 

Step 12 Specify the VNDS config file archive directory. 

a. Type an archive directory path in the panel’s path field or use the file browser 
to select a path. The path you choose cannot contain embedded spaces.

Note The archive directory holds collected device configuration files that 
have been archived by the product. The path you specify is the full 
path to this directory. 

b. Click Next. 

The installer prompts you to configure server parameters. 

Step 13 Specify server information for this instance of Cisco VNDS. The installer 
prompts you for the following information: 

– Virtual Network Data Server Name

– Virtual Network Data Server ID (0-1022)

– Virtual Network Data Server Address

a. Type the primary IP address of the host in the 
Cisco Virtual Network Data Server Address field. 

Note The primary IP address is required for all VNDS installations. To 
obtain the IP address, open a command window and run the ipconfig 
command.
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b. Fill in additional fields if this instance of Cisco VNDS will participate in an 
n-tier hierarchy.

c. Click Next. 

The installer displays the Configure Cisco Virtual Network Data Server 

Client Connectivity panel.

Step 14 Specify the VNDS Client Connectivity Port.

Type a port number or click Next to accept the default value.

Note The Client Connectivity port is the port on which the Live Update 
Service runs. If you enter a non-default port, VNDS clients might be 
unable to communicate with Cisco VNDS until you make a 
corresponding change in the client preferences. 

The installer displays a panel for configuration of the web server.

Step 15 Specify web server connectivity information. 

a. The installer prompts you for the following: 

– HTTP Port

– HTTPS Port

– Keystore Directory

b. Fill in each field or click Next to accept default values.

The installer prompts you to set the Web Server Administrator password. 

Note Write down the web server connectivity settings for future use.

Step 16 Specify the password for the administrator (admin) user account for the 
Cisco Virtual Network Data Server Web Console. The installer prompts you for 
the following information: 

– Enter administrator password

– Confirm administrator password

Type a password into the password fields or click Next to accept the default 
(cisco). 
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Note Write down the admin password. You will need this password to log 
into the Cisco Virtual Network Data Server Web Console for the first 
time—the VNDS Web Server is installed in the local authentication 
mode by default. Once logged into the Web Console, the admin user 
can change the admin password, create user accounts, or change the 
authentication scheme.

The installer prompts you to configure email notification parameters.

Step 17 If you want to begin receiving email notification as soon as you start VNDS 
services, configure email notifications at this time. Otherwise, configure 
notifications when you are ready to begin automated operation (recommended) 
using the Notification panel in the Cisco Virtual Network Data Server 
Administrative Console.

a. Enter the sender, recipients, and subject prefix for VNDS email notifications 
or leave these fields blank if you want to configure email notifications 
post-installation. 

b. Click Next to proceed. 

The installer prompts you for email server settings. 

c. Enter the SMTP Server, Port, User Name, and Password (if you want to 
configure email notifications post-installation, leave these fields blank). 

d. Click Next to proceed. 

An installation progress panel shows status messages as VNDS installation 
progresses. Installation normally finishes in several minutes. 

– If an existing VNDS 3.5 installation is detected, the installer displays the 
Migrate Cisco Virtual Network Data Server Product 

Configuration panel. Proceed to Step 18. 

Note The installer checks the version of the Oracle Toplink files that you 
chose in Step Step 7. If the wrong version files were selected, an error 
dialog box appears. Click OK to continue. Before operating Virtual 
Network Data Server, you must locate the correct version of the 
required Toplink files and copy them to the <install dir>\ext directory
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– If you are installing on a host that does not have Cisco VNDS 3.5 
software installed, the installer displays the Web Services Note panel 
when installation is complete. Jump to step 19. 

Step 18 Migrate the configuration settings from the previous version of 
Cisco Virtual Network Data Server to the current version (optional). 

To migrate previous settings, perform the following steps:

– Select Yes in the Migrate Cisco Virtual Network Data Server Product 
Configuration panel, then click Next. 

A Confirm dialog box displays. It provides the path of the previous 
installation (from which it will migrate product configuration) and lists 
the actions that will be performed if you proceed.

– Click Yes to continue with migration. Click No to skip migration and 
proceed to step 19.

Progress dialog boxes display during product configuration. A Status 
dialog box displays when migration is complete. This dialog summarizes 
the actions performed and provides the location of migration logs. Click 
OK and proceed to step 19.

Note During migration, VNDS 3.5 device info file is copied to the 4.0 
installation. However, it is not converted to the 4.0 format or 
imported into Cisco VNDS. See the Release Notes for important 
notes on updating.

To install without migrating previous settings, perform the following steps: 

– Select No in the Migrate Cisco Virtual Network Data Server 

Product Configuration panel then click Next. 

A Notice dialog displays. 

– Click OK to proceed to step 19. Click Previous to go back to the Migrate 
Cisco Virtual Network Data Server Product Configuration panel.
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Note If you chose not to migrate but want to preserve groups, you must 
export this information from the database before you configure 
the database for 4.0. You can migrate adapter resources and text 
files after installation is complete as long as you do not uninstall 
or delete files from the previous release installation directory. See 
the Administration chapter of the 
Cisco Virtual Network Data Server User Guide for instructions 
on how to run the migration tools. 

Step 19 Read the Web Services Note. 

Note VNDS software is installed in HTTP mode. You can optionally configure 
HTTPS after you have completed your installation workflow. See the 
HTTPS Mode section of the Release Notes for more information.

Step 20 Click Next. 

The installer displays the Install Complete panel. 

Step 21 Click Done to exit the installer. 

Note Installation of VNDS software is now complete. Return to the workflow 
you are following and continue with the next step. Do not attempt to start 
Cisco VNDS or access the Web Console until you complete all steps in 
the installation workflow.

Note Refer to the Cisco Virtual Network Data Server User Guide, Administration 
chapter, Licensing Operations section for instructions on adding a license.

After you have installed VNDS software, see Configuring the Oracle Database for 
Cisco VNDS (Windows), page 3-17. 
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Configuring the Oracle Database for Cisco VNDS 
(Windows)

After you install the current version of Cisco Virtual Network Data Server, you 
must configure the Oracle database for use by Cisco VNDS. This involves 
running an SQL script named setup_accounts.sql that creates tablespaces for 
the database and a VNDS access account. 

Warning Do not modify the setup_accounts.sql script. This can cause the installation 
to fail or prevent Cisco Virtual Network Data Server from operating 
correctly.

To configure the Oracle database, perform “Configuring the Oracle Database 
(Windows)” section on page 3-17.

Configuring the Oracle Database (Windows)

Step 1 If the Oracle database and Cisco VNDS are located on the same host system, open 
a command window and navigate to the Cisco Virtual Network Data Server 
installation directory by typing 

cd <install path>\VNDServer\<release_number>_<build_number> 

Stay in the command window on the host system for Cisco VNDS, and continue 
with step 2. 

Step 2 Log into Oracle using the system account.

• For a local Oracle database installation enter the following command: 

sqlplus system/<system password> 

• For a remote Oracle database, enter the following command: 

sqlplus system/<system password>@<DB TNS Service Name> 

For example, if the Database is remote with a TNS Service Name of o92avnes 
and the Oracle system password is magic, type: 

sqlplus system/magic@o92avnes 

Step 3 Enter the following command at the SQL> prompt:

@setup_accounts.sql
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A message banner displays to inform you how much free disk space is required 
on the disk that hosts the database. 

Note If you do not have sufficient disk space available to run this script, free up 
sufficient disk space before proceeding. If you want to cancel the script, 
press Ctrl-C or close the command window. 

Step 4 Click Enter to continue. 

A message banner displays a notification about Device and Platform Info. 

• For Oracle9i, proceed to step 5.

• For Oracle10g, jump to step 6.

Step 5 Click Enter to continue.

When you configure Oracle 9i, a message banner displays with a list of database 
parameters, database parameter settings, and whether the parameters meet 
recommended settings. A log of database analysis results is saved to 
<install_dir>\analyzedb.<timestamp>.log. 

Note If all parameters meet recommended settings, no further action is 
required. If one or more parameters do not meet recommended settings, 
the installer recommends that you run the dbparamchg.sql script after this 
procedure is completed; this will improve data import performance with 
large networks and increase Oracle memory requirements. 

Step 6 Click Enter to continue. 

A database name displays. 

Step 7 Verify the database instance name.

Note If the database is located on a Solaris or Linux system, the case 
(uppercase, lowercase) of the characters in the database instance name 
must be a case-sensitive match of the name of the database directory 
located under the oradata directory (e.g., /uo1/app/oracle/oradata) on 
the database host. Look in the oradata directory to ensure that, when you 
enter the database instance name, it is a case-sensitive match.
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Step 8 Click Enter to continue. 

The setup_accounts script prompts you for the database instance name. 

Step 9 Enter the database instance name obtained in step 7.

The setup_accounts script prompts you for the user password. 

Step 10 Enter the same database user account password that was entered during VNDS 
installation and written down in Table A-1 on page A-14.

A message displays to inform you that the VNDS user account and all data will 
be deleted by this script. 

Step 11 Click Enter to continue. 

The setup_accounts SQL script configures database storage for use by 
Cisco VNDS and sets up the user account. After the script finishes, the Oracle 
account information for Cisco VNDS is the user name and password from 
Table A-1 on page A-14. A log of script actions is saved to the following location:

<install_dir>\setup_accounts.<timestamp>.log

Note When you run this script for the first time, several SQL error messages 
appear. You can ignore these messages. The messages are the result of the 
script trying to remove VNDS table and user accounts that do not exist 
prior to this script being run for the first time. 

Step 12 Type quit at the SQL> prompt to exit sqlplus. 

If the setup_accounts script recommended changing your database settings during 
step 5, and you agree with the recommended changes, see Modifying Database 
Parameters (Windows), page 3-20 at this time. 

If you do not need to change your database settings or choose not to change them, 
see Verifying the Oracle Configuration for Cisco VNDS (Windows), page 3-21 to 
verify that Oracle is configured correctly for use with Cisco VNDS.
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Modifying Database Parameters (Windows)
Perform Modifying Database Parameters (Windows), page 3-20 on the Oracle 9i 
database host to modify database parameters. The database parameter changes 
improve VNDS performance when working with large networks and will increase 
Oracle memory requirements. 

Do not modify database parameters for Oracle 10g unless instructed to do so by 
Cisco Technical support. 

Note Work with your Database Administrator to run this script. 

Modifying Database Parameters (Windows)

Step 1 Log into Oracle using the system account.

• For a local Oracle database installation: 

Type sqlplus system/<system password> in the command window. 

• If the Oracle database is not on the same host system as Cisco VNDS, then 
perform the following steps:

Type sqlplus system/<system password>@<DB TNS Service Name> 

For example, if the Database is remote with a TNS Service Name of o92avnes 
and the Oracle system password is magic, type: 

sqlplus system/magic@o92avnes 

Step 2 Enter the following command at the SQL> prompt: 

@dbparamchg.sql 

A message shows the path to the Oracle spfile that contains the parameters for 
your database. 

Step 3 Make a backup copy of the spfile at the path specified in the previous step. 

Step 4 Press Enter as many times as needed to step through information messages 
produced by this script. 

When the script is done, a list of the changed parameters and their new settings 
appears with a reminder to restart the Oracle DB service for the changes to take 
effect. 
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Step 5 Type quit at the SQL> prompt to exit sqlplus. 

Step 6 Use the Windows Service Manager to stop and restart the Oracle database service. 

a. From the desktop, select Start > Settings > Control Panel > Administrative 
Tools > Services to open the Windows Service Manager. 

b. Select the service named OracleService<DB SID>.

c. Right-click on the service, and select Stop from the menu. 

d. After the Service Control progress dialog completes, right-click on the 
service, and select Start from the menu to restart the service. 

Step 7 If the Oracle database service fails to restart, restore the original spfile for the 
database and repeat step 6 to recover. 

See “Verifying the Oracle Configuration for Cisco VNDS (Windows)” section on 
page 3-21 to verify that you can connect to the database through the VNDS 
account. 

Verifying the Oracle Configuration for 
Cisco VNDS (Windows)

Perform the follow procedure on the VNDS host to verify that you can connect to 
the database through the VNDS account.

Verifying the Oracle Configuration (Windows)

Step 1 Open a command window.

Step 2 Navigate to the VNDS installation directory. 

Step 3 Verify that you can log in into Oracle using the VNDS account. 

• For a local Oracle database, enter the following command:

sqlplus <user name>/<password>

Use the user name and password from Table A-1 on page A-14. 

• For a remote Oracle database, enter the following command:
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sqlplus <user name>/<password>@<DB TNS Service Name> 

Use the user name and password from Table A-1 on page A-14. For example, 
if the database is remote with a TNS Database Service Name of o92avnes and 
the VNDS username and password are vnes and pwd respectively, enter: 

sqlplus vnes/pwd@o92avnes 

Step 4 If Oracle configuration was not successful, error messages display indicating that 
login has been denied.

Reconfigure the Oracle database and verify again.

Step 5 If configuration of the Oracle account for Cisco VNDS was successful, an Oracle 
banner, and a Connected To: message appears. 

Step 6 Type quit at the SQL> prompt to exit. 

Step 7 Test the Oracle database configuration.

a. Enter the following command:

vnes.bat DBAUTOTEST

Tests run to verify that the VNDS account can perform needed operations in 
Oracle. 

Output is written to the command window and a separate java window opens 
to display a summary of results.

b. Review DBAUTOTEST results. 

Note Do not proceed until all tests pass. Figure 3-1 on page 3-23 shows a 
successful result.

If any of the database tests fail, contact Cisco Technical Support (as described 
in “Obtaining Technical Assistance” section on page fm-viii).

When all database tests pass, continue with your installation roadmap.
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Figure 3-1 Example of Successful DBAUTOTEST Results 

VNDS program installation and database configuration are now complete. 
Proceed to Verifying the VNDS Software Installation (Windows), page 3-23 to 
verify the VNDS installation. 

Verifying the VNDS Software Installation 
(Windows)

After the database has been configured and verified, perform the following 
procedure to verify that the VNDS software is installed correctly.

Verifying the VNDS Installation (Windows)

Step 1 Verify that the license server specified during installation has required licenses 
installed. 

Note Do not proceed until you have verified that the appropriate licenses are 
available.
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Step 2 Open the Cisco Virtual Network Data Server Control Panel from the Program 
Group shortcut as follows. 

Start > Programs > Cisco Virtual Network Data Server 2.0 > 
Virtual Network Data Server 

Within a minute, the Cisco Virtual Network Data Server Control Panel appears. 

Step 3 Start VNDS services from the Control Panel by clicking the Start Services button 
on the tool bar. 

A progress dialog appears, and within a few minutes, service start-up completes. 

Step 4 Stop VNDS services from the Control Panel by clicking the Stop Services button 
on the tool bar.

A progress dialog box appears; services should stop within a few minutes. 

Note If the Control Panel fails to open, services fail to start or stop, or error 
dialog boxes appear, there is a problem with the installation. Review 
Release Notes for known issues and workarounds; you can also search for 
troubleshooting information in the FAQ database at the Cisco Quick 
Support Center. Contact Cisco Technical Support for assistance if 
problems persist (for more information, see “Obtaining Technical 
Assistance” section on page fm-xii).

Step 5 Verify communication with the VNDS Web Server via HTTP.

a. Start the Cisco Virtual Network Data Server Web Service using the Windows 
services window.

b. Open a web browser and enter the URL for the VNDS Web Console. 

<protocol>://<host>:<port>/vnes

For example, if the VNDS host is myhost.myco.com and the http port is 9190, 
enter the following:

http://myhost.myco.com:9190/vnes

c. Close the browser window.

Step 6 Click the Exit button on the Control Panel tool bar to exit from Cisco VNDS. 

Step 7 Some VNDS services continue to run in the background. If you want to 
completely shut down Cisco VNDS, stop all services. 
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To stop all services, do the following:

a. Open a commend window and navigate to theVNDS install directory.

b. Enter the following command:

vnes.bat /svc_cmd stop ALL 
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4
Installing 
Cisco Virtual Network Data Server 
(Linux)

This chapter describes how to install the Cisco Virtual Network Data Server 
program on Linux. 

System Requirements 

Note The host for Cisco Virtual Network Data Server must meet minimum system 
requirements. If the host system does not meet minimum requirements, do not 
install Cisco VNDS. For more information, see 
Cisco Virtual Network Data Server: System Requirements, page 2-1.

If the host system does not have an Oracle database or an Oracle client 
installation, but meets all other requirements, install Oracle before installing 
Cisco VNDS as described in the “Installation Workflows: Overview” section. 

4
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Installation Workflows: Overview 
This chapter covers the installation scenarios you might encounter with 
Cisco VNDS on Linux. The procedures you must follow depend upon whether 
VNDS uses a local or a remote database. 

Select the installation workflow appropriate for your circumstances. Follow the 
procedures in your workflow to install Cisco VNDS. 

• Initial VNDS Installation (Linux/Local Oracle Database), page 4-2

• Initial Cisco VNDS Installation (Linux/Remote Oracle Database), page 4-3

Note VNDS software is installed in HTTP mode by default. After successful 
installation and verification of the VNDS software, HTTPS may be configured. 
See the “HTTPS Mode” section of the Release Notes for more information.

Initial VNDS Installation (Linux/Local Oracle Database)
If you are installing Cisco VNDS for the first time and will install Oracle on the 
same host, follow this workflow.

Step 1 Install the Oracle database on the VNDS host. 

For more information, see Oracle Installation Procedures, page B-1.

Step 2 Collect Oracle database information (see Collecting Oracle Database Access 
Information (Linux), page B-3). 

Step 3 Install Oracle TopLink.

See the “Installing Oracle TopLink (Linux)” procedure on page B-4.

Note You must complete the previous steps before you install Virtual Network 
Data Server.

Step 4 Install the Cisco Virtual Network Data Server program (see Installing 
Cisco VNDS (Linux), page 4-4).
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Step 5 Configure the Oracle database for VNDS (see Configuring the Oracle Database 
for Cisco VNDS (Linux), page 4-14). 

Step 6 Verify the Oracle configuration for VNDS (see Verifying Oracle Configuration 
for Cisco VNDS (Linux), page 4-19). 

Step 7 Verify the VNDS installation (see Verifying the VNDS Software Installation 
(Linux), page 4-21). 

Initial Cisco VNDS Installation (Linux/Remote Oracle 
Database)

If you are installing Cisco VNDS for the first time and will install Oracle on a 
different host, follow this workflow:

Step 1 Install the Oracle database on the remote host. 

For information about installing the Oracle database, see Appendix A, “Oracle 
Procedures (Windows)” or Appendix B, “Oracle Procedures (Linux)”.

Step 2 Install the Oracle client on the host for Cisco VNDS. 

Note Install the version of the client that matches the version of the database 
that you installed in step 1.

For more information, see Appendix B, “Oracle Procedures (Linux).”

Step 3 Collect Oracle database information (use the procedure for the platform on which 
the remote database is installed):

• “Collecting Oracle Database Access Information (Windows)” procedure on 
page A-13 

• “Collecting Oracle Database Access Information (Linux)” procedure on 
page B-3

Step 4 Install Oracle TopLink.

See the “Installing Oracle TopLink (Linux)” procedure on page B-4.
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Note You must complete the previous steps before you install Virtual Network 
Data Server.

Step 5 Install the Cisco Virtual Network Data Server program (see Installing 
Cisco VNDS (Linux), page 4-4).

Step 6 Configure the Oracle database on the remote host (see Configuring the Oracle 
Database for Cisco VNDS (Linux), page 4-14). 

Step 7 Verify the Oracle configuration on the remote host (see Verifying Oracle 
Configuration for Cisco VNDS (Linux), page 4-19). 

Step 8 Verify the VNDS installation (see Verifying the VNDS Software Installation 
(Linux), page 4-21). 

Installing Cisco VNDS (Linux)
Perform the following procedures to install the 
Cisco Virtual Network Data Server program:

1. Performing Pre-Installation Checks for Cisco VNDS (Linux), page 4-4

2. Installing Cisco VNDS (Linux), page 4-5

Performing Pre-Installation Checks for Cisco VNDS (Linux)

Step 1 Make sure the Oracle database is up and running.

Enter the following command on the database host:

ps -aef | grep ora_

You should see a number of processes with the following naming convention:

ora_<process>_<sid>

If the Oracle database is not running, contact your database administrator to start 
the database.
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Step 2 If Cisco VNDS is already installed on the host and you are updating to a new 
release, perform the following steps to make sure that all VNDS services are 
stopped.

a. Log into the VNDS host as root or a user with permission to run VNDS or 
switch users to one of these accounts. When switching users, use the 
following command:

su - <user_name> 

b. Navigate to the VNDS installation directory.

c. Enter the following command to determine whether VNDS services are 
running:

ps -aef | grep wrapper

d. Stop any VNDS services that are running. Navigate to the VNDS installation 
directory and enter the following command:

vnes.sh -c stop ALL

Installing Cisco VNDS (Linux)

Step 1 Log into the VNDS host as root or switch users to root. To switch to root, open 
a command prompt window and enter the following command:

su - root 

Step 2 Start the installer. 

a. Insert the Cisco Virtual Network Data Server installation CD into the CD 
drive of the host, then execute the cvnds-2.0-lin-K9.bin program. 

As an example, open a command window and navigate to the folder that 
corresponds to the CD drive (e.g., /media/cdrecorder), then enter 
./cvnds-2.0-lin-K9.bin.

The installer displays an Introduction panel. 

b. Click Next. 

The installer displays a Specify database type panel. 

Step 3 Specify parameters that describe the Oracle installation that Cisco VNDS will 
use. The installer prompts you for the following: 

• Choose whether the database is local or remote
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• Choose whether you are using a 32 bit or 64 bit Oracle

Make your selections, then click Next. 

The installer displays a Specify an Oracle database panel.

Step 4 Specify the Oracle database that Cisco VNDS will use. The installer prompts you 
for the following database access information: 

• Database TNS Service Name

• Database SID

• Database Hostname

• Local Oracle Installation Dir

• Base Dir for Database

Fill in each field with the information collected in Table B-1 on page B-3 and 
click Next. 

The installer displays the Specify account information for the Oracle 
database panel.

Step 5 Specify values for the account that Cisco VNDS will use to access the Oracle 
database.

• Database User Name

• Database Password

• Confirm Password

Fill in each field with the information collected in Table B-1 on page B-3 and 
click Next.

Note Select a user name that is dedicated for use by Cisco VNDS. DO NOT use 
SYS or SYSTEM for the Local Database User Name.

If you specified a remote database in Step 3, the installer displays the Choose the 
Oracle version panel. Proceed to Step 6.

If you specified a local database in Step 3, the installer prompts you for the 
location of the Oracle TopLink files. Jump to Step 7.

Step 6 Specify the Oracle version for the remote database. The choices are: 

• Oracle9i 
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• Oracle10g

Choose the appropriate Oracle version, then press Next to continue. The installer 
prompts you for the location of the Oracle Toplink files.

Step 7 The installer prompts you for the location of Oracle Toplink files required by 
Cisco VNDS. 

Note Note: Version 9.0.3.5 of Oracle Toplink is required. 

a. If you have Toplink installed to the default path within your existing Oracle 
installation, the default path shown in this panel is the correct path. Locate 
the path on your system that contains the following Toplink files: 
tl_core.jar tl_tools.jar tl_x.jar

b. Click Choose and browse to the directory of the required Oracle Toplink files. 
Click Select to complete your choice. 

c. Click Next. If the required files are not found at the selected path, an error 
dialog appears. Click one of the following:

– OK to try again to select a path. 

– Cancel to cancel the installation.

Step 8 Specify the licensing type (see Licensing Notes, page 4-13 for more information).

a. The installer prompts you for the type of licensing to use. The Select 
Licensing Type panel provides the following choices:

– Access licenses from a remote server 

– Serve licenses from a new license server on this computer 

– Serve licenses from an existing license server on this computer 

b. Choose the licensing type, then click Next. 

Note The specified license server must have a valid VNDS license before 
you can run the software. 

If you selected remote licensing, the installer displays the Enter Server Name 
and Port panel. Proceed to step c.

If you selected local licensing, the installer displays the Enter Port panel. 
Jump to step d. 
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c. The installer prompts you for the server name and port. 

– Type the hostname of the remote license server in the Server field. 

– Type the port (port_a, port_b, or port_c) used by the remote license 
server in the Port field. 

– Click Next. 

The Choose the Cisco Virtual Network Data Server Installation folder panel 
displays. Proceed to Step 9.

Note Write down the license settings for future reference. 

d. The installer prompts you for the port used by the local license server (port_a, 
port_b, or port_c)

Accept the default value. Press Next to proceed.

The installer displays the Choose the 
Cisco Virtual Network Data Server Installation folder panel. 
Proceed to Step 9.

Step 9 Specify the VNDS installation directory. 

a. Type an installation path in the panel’s path field or use the file browser to 
select an installation path. The path you choose cannot contain embedded 
spaces. 

Note The path you enter is the parent directory for the installation. The 
installer adds \VNEServer\<version>_<build#> to the path you 
choose.

Note The installer suggests a default directory. Although you can override the 
default, Cisco strongly recommends that you install Cisco VNDS in its 
own, program-specific directory. Cisco also recommends that you do not 
install multiple Cisco Solution programs (such as Cisco VNDS and 
Cisco Audit and Analysis) in the same directory. 

b. Press Next. 

The installer displays the Enter File Ownership panel. 
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Step 10 Specify user and group ownership for the VNDS installation directory. The 
installer prompts you for the following information:

• User ID

• Group ID

Note The user must be a member of the specified group. The user will be the 
owner of the VNDS installation directory. Any user that is a member of 
the specified group will have appropriate permission to run the VNDS 
software.

Type a valid user name and group name into the appropriate fields then press 
Next. 

The installer displays the Choose the Cisco Virtual Network Data Server 

temp folder panel. 

Step 11 Specify the VNDS temporary directory. 

Type a temp directory path in the panel’s path field or use the file browser to select 
a path. The path you choose cannot contain embedded spaces.

Note The temp directory holds temporary working files for the product. The 
path you specify is the full path to this directory. 

Note Make sure that the specified directory has appropriate write permissions. 
The group specified in Step 10 must be able to write to this directory. 

a. Press Next. 

The installer displays the Choose the 
Cisco Virtual Network Data Server config file folder panel. 

Step 12 Specify the VNDS config file archive directory. 

a. Type an archive directory path in the panel’s path field or use the file browser 
to select a path. The path you choose cannot contain embedded spaces.
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Note The archive directory holds collected device configuration files that have 
been archived by the product. The path you specify is the full path to this 
directory. 

Note Make sure that the specified directory has appropriate write permissions. 
The group specified in Step 10 must be able to write to this directory. 

a. Press Next. 

The installer displays the Configure Cisco Virtual Network Data Server 
panel. 

Step 13 Specify server information for this instance of Cisco VNDS. The installer 
prompts you for the following information: 

• Virtual Network Data Server Name

• Virtual Network Data Server ID (0-1022)

• Virtual Network Data Server Address

a. Type the primary IP address of the host in the 
Cisco Virtual Network Data Server Address field. 

Note The primary IP address is required for all VNDS installations. To 
obtain the IP address, open a command window and run the ifconfig 
command.

b. Fill in additional fields if this instance of Cisco VNDS will participate in an 
n-tier hierarchy.

c. Press Next. 

The installer displays the Configure Cisco Virtual Network Data Server 

Client Connectivity panel.

Step 14 Specify the VNDS Client Connectivity port. 

Type a port number or press Next to accept the default value.
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Note The Client Connectivity port is the port on which the Live Update Service 
runs. If you enter a non-default port, VNDS clients might be unable to 
communicate with this service until you make a corresponding change in 
the client preferences. 

The installer displays the Configure Web Server Connectivity panel.

Step 15 Specify web server connectivity information. 

The installer prompts you for the following: 

• Virtual Network Data Server HTTP Port

• Virtual Network Data Server HTTPS Port

• Keystore Directory

a. Fill in each field or press Next to accept default values.

Note Write down the web server connectivity settings for future use.

The installer displays the Set Web Server Administrator Password panel.

Step 16 Specify the password for the administrator (cisco) user account for the VNDS 
Web Console. The installer prompts you for the following information: 

• Enter administrator password

• Confirm administrator password

Type a password into the password fields or press Next to accept the default 
password (cisco). 

Note Write down the admin password. You will need this password to log into 
the VNDS Web Console for the first time—VNDS Web Server is installed 
in the local authentication mode by default. Once logged into the Web 
Console, the admin user may change the admin password, create user 
accounts, or change the authentication scheme.

The installer prompts you to configure email notification parameters.
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Step 17 If you want to begin receiving email notification from Cisco VNDS as soon as you 
start VNDS services, configure email notifications at this time. Otherwise, 
configure notifications when you are ready to begin automated operation 
(recommended) using the Notification panel in the VNDS Administrative 
Console.

a. Enter the sender, recipients, and subject prefix for VNDS email notifications 
or leave these fields blank if you want to configure email notifications 
post-installation. 

b. Click Next to proceed. 

The installer prompts you for email server settings. 

c. Enter the SMTP Server, Port, User Name, and Password or leave these fields 
blank if you want to configure email notifications post-installation. 

d. Click Install. 

An installation progress panel shows status messages as VNDS installation 
progresses. Installation normally finishes in several minutes. When 
installation is complete, the Web Services Note panel displays. 

Note The installer checks the version of the Oracle Toplink files that you chose 
in Step 7. If the wrong version files were selected, an error dialog box 
appears. Click OK to continue. Before operating Virtual Network Data 
Server, you must locate the correct version of the required Toplink files 
and copy them to the <install dir>/ext directory. 

Step 18 Read the Web Services Note. 

Note VNDS software is installed in HTTP mode. You can optionally configure 
HTTPS after you have completed your installation workflow. See the 
“HTTPS Mode” section of the Release Notes for more information.

Click Next to proceed.

The installer displays the Install Complete panel.

Step 19 Click Done to exit the installer. 
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Note Installation of VNDS software is now complete. Return to the workflow 
you are following and continue with the next step. Do not attempt to start 
Cisco VNDS or access the Web Console until you complete all steps in 
the installation workflow.

After you have installed VNDS software, see Configuring the Oracle Database for 
Cisco VNDS (Linux), page 4-14. 

Licensing Notes
You must specify a licensing type for the VNDS software during installation. The 
installer provides the following options:

• Access licenses from a remote server—Selecting this option results in the 
VNDS software obtaining a license from a remote host.

• Serve licenses from a new license server on this computer—Selecting this 
option results in a license server being installed with the VNDS installation. 
The license server executable installed by Cisco Virtual Network Data Server 
version 4.0 is the same version license server that is included with programs 
in other Cisco Solution packages (such as the program included in the Cisco 
Configuration Assurance Solution) . To start the license server, enter the 
following from a command prompt:

vnes.sh -l <license_server_host> -p <port> LS 

Note The license server program must be manually restarted when the 
server reboots.

• Serve licenses from an existing license server on this computer—Selecting 
this option configures Cisco VNDS to use a license server that is already 
installed on the host as part of an existing Cisco VNDS or Cisco Solution 
package. No license server is installed by the VNDS installer.
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Note The specified license server must have a valid VNDS license before you 
can run the software. Check to see if the license server has a valid VNDS 
license before you attempt to run the VNDS software. Add a license, if 
needed. Refer to the Cisco Virtual Network Data Server User Guide, 
Administration chapter, Licensing Operations section for instructions on 
adding a license.

Configuring the Oracle Database for Cisco VNDS 
(Linux)

After VNDS software is installed, the Oracle database must be configured for use 
by VNDS. This involves running an SQL script named setup_accounts.sql that 
creates tablespaces for the database and a VNDS access account. This SQL script 
is run on the host system for the Oracle database. 

Warning Do not modify the setup_accounts.sql script. This can cause the installation 
to fail or prevent VNDS from operating correctly.

See Configuring the Oracle Database (Linux), page 4-14 for instructions on 
configuring the Oracle database.

Configuring the Oracle Database (Linux)

Step 1 Log into the VNDS host as oracle or switch users to the oracle account. To 
switch to oracle, open a command prompt window and enter the following 
command:

su - oracle 

Step 2 Copy the SQL scripts from the VNDS installation directory to a directory on the 
database host where the oracle user has execute permission. The SQL scripts 
have a file extension of .sql.

Step 3 Navigate to the directory that contains the SQL scripts. 
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Stay in the command window on the database host (as oracle) and continue with 
step 4.

Step 4 Log into Oracle using the system account.

• For a local Oracle database installation, type the following command in the 
command window:

sqlplus system/<system password> 

• For a remote Oracle database installation, type the following command in the 
command window:

sqlplus system/<system password>@<DB TNS Service Name> 

For example, if the Database TNS Service Name is o92avnes and the account 
password is magic, type: 

sqlplus system/magic@o92avnes 

Step 5 Enter the following command at the SQL> prompt:

@setup_accounts.sql 

A message banner appears that states how much free disk space is required on the 
disk that hosts the database. 

Note If you do not have sufficient disk space available to run this script, free up 
sufficient disk space before proceeding. If you want to cancel the script, 
press Ctrl-C or close the command window. 

Step 6 Press Enter to continue. 

A message banner displays a notification about Device and Platform Info. 

• For Oracle9i, proceed to step 7.

• For Oracle10g, jump to step 8.

Note If you want to cancel the script, press Ctrl-C or close the command 
window.

Step 7 Press Enter to continue.
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When configuring Oracle 9i, database parameters are analyzed and a message 
banner displays with a list of database parameters, database parameter settings, 
and whether the parameters meet recommended settings. A log of database 
analysis results is saved to <install_dir>\analyzedb.<timestamp>.log. 

Note If all parameters meet recommended settings, no further action is 
required. If one or more parameters do not meet recommended settings, 
the installer recommends that you run the dbparamchg.sql script after 
you complete this procedure. This will improve data import performance 
with large networks and increase Oracle memory requirements. 

Step 8 Press Enter to continue. 

A database name appears. If more than one database is available, contact your 
database administrator to find out which database name to use with Cisco VNDS.

Step 9 Verify the database instance name.

Note If the database is located on a Solaris or Linux system, the database 
instance name must be a case-sensitive match of the name of the database 
directory located under the oradata directory (for example, 
/uo1/app/oracle/oradata) on the database host. Look in the /oradata 
directory to ensure that when you enter the database instance name it is a 
case-sensitive match.

Step 10 Press Enter to continue. 

The setup_accounts script prompts you for the database instance name. 

Step 11 Enter the database instance name obtained in step 9.

The setup_accounts script prompts you for the user password. 

Step 12 Enter the same database user account password that was entered during VNDS 
installation and written down in Table B-1 on page B-3.

The script informs you that the VNDS user account and all data will be deleted by 
this script. 

Step 13 Press Enter to continue. 
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The setup_accounts SQL script configures database storage for use by VNDS 
and sets up the user account. After the script finishes, the Oracle account 
information for Cisco VNDS is the user name and password from Table B-1 on 
page B-3. A log of script actions is saved to 
<install_dir>\setup_accounts.<timestamp>.log.

Note When you run this script for the first time, several SQL error messages 
appear. You can ignore these messages. The messages are the result of the 
script trying to remove VNDS table and user accounts that do not exist 
prior to this script being run for the first time. 

Type quit at the SQL> prompt to exit sqlplus.

If the setup_accounts script recommended changing your database settings during 
step 7, and you agree with the recommended changes, see Modifying Database 
Parameters (Linux), page 4-17 at this time. 

If you do not need to change your database settings or choose not to change them, 
see Verifying Oracle Configuration for Cisco VNDS (Linux), page 4-19 to verify 
that Oracle is configured correctly for use with Cisco VNDS. 

Modifying Database Parameters (Linux)
Perform Modifying Database Parameters (Linux), page 4-18 on the Oracle 9i 
database host to modify database parameters. The database parameter changes 
improve VNDS performance when working with large networks and will increase 
Oracle memory requirements. 

Do not modify database parameters for Oracle 10g unless instructed to do so by 
Cisco Technical support (see Obtaining Technical Assistance, page fm-xii).

Note Work with your Oracle Database Administrator to run this script. 
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Modifying Database Parameters (Linux)

Step 1 Log into the database host as oracle or switch users to the oracle account. To 
switch to oracle, open a command prompt window and enter the following 
command:

su - oracle 

Step 2 Open a command window.

Step 3 Navigate to the VNDS installation directory or directory where you copied the 
VNDS SQL scripts. 

Stay in the command window on the database host (as ) and proceed with Step 4.

Step 4 Log into Oracle using the system account.

• For a local Oracle database installation, type the following command in the 
command window: 

sqlplus system/<system password> 

• If the Oracle database is not on the same host system as Cisco VNDS, type 
the following command in the command window: 

sqlplus system/<system password>@<DB TNS Service Name> 

For example, if the Database TNS Service Name is o92avnes and the account 
password is magic, type: 

sqlplus system/magic@o92avnes 

Step 5 Enter the following command at the SQL> prompt:

@dbparamchg.sql 

A message is displayed that shows the path to the Oracle spfile that contains the 
parameters for your database. 

Step 6 Make a backup copy of the spfile at the path specified in the previous step. 

Step 7 Press Enter as many times as needed to step through information messages 
produced by this script. 

When the script is done, a list of the changed parameters and their new settings 
appears with a reminder to restart the Oracle DB service for the changes to take 
effect. 

Step 8 Type quit at the SQL> prompt to exit sqlplus. 

Step 9 Stop and restart the Oracle database service. 
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Step 10 If the Oracle database service fails to restart, restore the original spfile for the 
database and repeat step 9 to recover. 

See Verifying Oracle Configuration for Cisco VNDS (Linux), page 4-19 to verify 
that you can connect to the database through the VNDS account. 

Verifying Oracle Configuration for Cisco VNDS 
(Linux)

Perform the following procedure on the database host to verify that Oracle is 
configured correctly for use with Cisco VNDS.

Verifying the Oracle Configuration (Linux)

Step 1 Log in to the database host as oracle or switch users to oracle. To switch to 
oracle, open a command prompt window and enter the following command:

su - oracle 

Step 2 Open a command window.

Step 3 Verify that you can log into Oracle using the VNDS account.

• For a local Oracle database, enter the following command:

sqlplus <user name>/<password> 

Use the user name and password from Table B-1 on page B-3. 

• For a remote Oracle database, enter the following command:

sqlplus <user name>/<password>@<DB TNS Service Name> 

Use the user name and password from Table B-1 on page B-3. For example, 
if the Database TNS Service Name is o92avnes and the VNDS username and 
password are vnes and pwd respectively, enter: 

sqlplus vnes/pwd@o92avnes 

Step 4 If Oracle configuration was not successful, error messages notify you that login 
has been denied.
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• Reconfigure the Oracle database and verify again.

Step 5 If configuration of the Oracle account for Cisco VNDS was successful, an Oracle 
banner, and a Connected To: message appears. 

Step 6 Type quit at the SQL> prompt to exit. 

Step 7 Test the Oracle database configuration.

a. Switch users to root or a user with permission to run Cisco VNDS. When 
switching users, open a command prompt window and enter the following 
command:

su - <user> 

For example, you might enter su - vnds_user 

b. Navigate to the VNDS installation directory. 

Enter the following command:

vnes.sh DBAUTOTEST 

Tests run to verify that the VNDS account can perform needed operations in 
Oracle. 

Output is written to the command window and a separate java window opens 
to display a summary of results.

c. Review DBAUTOTEST results. 

Note Do not proceed until all tests pass. Figure 4-1 shows a successful 
result.

– If any of the database tests fail, contact Cisco Technical Support for 
assistance and provide the DBAUTOTEST results (for more information, 
see Obtaining Technical Assistance, page fm-xii).

– When all database tests pass, continue with your installation workflow.
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Figure 4-1 Example of Successful DBAUTOTEST Results 

VNDS installation and database configuration are now complete. Proceed to 
Verifying the VNDS Software Installation (Linux), page 4-21 to verify the VNDS 
installation. 

Verifying the VNDS Software Installation (Linux)
After the database has been successfully configured for Cisco VNDS, perform the 
following procedure to verify that the VNDS software is installed correctly.

Verifying the VNDS Installation (Linux)

Step 1 Verify that the license server specified during installation has the required licenses 
installed.

Note Do not proceed until you have verified that the appropriate licenses are 
available.

Step 2 Log in to the VNDS host as a member of the VNDS group or switch to a user that 
is a member of the VNDS group. When switching users, open a command prompt 
window and enter the following command:
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su - <user> 

For example, you might enter su - vnds_user 

Step 3 Open the Cisco Virtual Network Data Server Control Panel as follows: 

a. Open a command window and navigate to the VNDS installation directory. 

b. Enter the following command: 

vnes.sh CP 

Within a minute, the Cisco Virtual Network Data Server Control Panel 
appears. 

Step 4 Start VNDS services from the Control Panel by clicking the Start Services button 
on the tool bar. 

A progress dialog appears, and within a few minutes, service start-up completes. 

Step 5 Stop VNDS services from the Control Panel by clicking the Stop Services button 
on the tool bar.

A progress dialog appear appears; services should stop within a few minutes. 

Note If the Control Panel fails to open, services fail to start or stop, or error 
dialog boxes appear, there is a problem with the installation. Contact 
Cisco Technical Support for assistance if problems persist (for more 
information, see Obtaining Technical Assistance, page fm-viii).

Step 6 Verify communication with the VNDS Web Server via HTTP.

a. Start the VNDS Web Service by entering the following command: 

vnes.sh -c start WS 

Note You must start the Web Service manually before you can access the 
Web Console. 

b. Open a web browser and enter the URL for the 
Cisco Virtual Network Data Server Web Console. 

<protocol>://<host>:<port>/vnes 

As an example, if the VNDS host is myhost.myco.com and the http port is 
9190, enter:



4-23
Installation Guide for Cisco Virtual Network Data Server

OL-11599-01

Chapter 4       Installing Cisco Virtual Network Data Server (Linux)
    Verifying the VNDS Software Installation (Linux)

http://myhost.myco.com:9190/vnes 

The login page displays.

c. Close the browser window.

Step 7 Click the Exit button on the Control Panel tool bar to exit from Cisco VNDS. 

Step 8 Some VNDS services continue to run in the background. If you want to 
completely shut down VNDS, stop all services (vnes.sh -c stop ALL).

Note If you manually stop the Web Service or shut down VNDS by stopping all 
services, you must manually start the Web Service before you can access 
the Web Console. See substep a. of Step 6.

Note Before using Virtual Network Data Server, you must change the default 
port that Cisco Network Planning Solution’s Design and Analysis or 
Cisco Configuration Assurance Solution’s Audit and Analysis uses to 
connect to VNDS. Search the known product issues (as described in 
Appendix D, “Known Issues”) for details on how to configure Audit and 
Analysis or Design and Analysis to successfully import from a Virtual 
Network Data Server running on Linux.
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5
Managing Licenses

To start a Cisco Solutions program such as Cisco Virtual Network Data Server, 
you must have a valid license for that program installed on the local or a remote 
computer. 

This chapter describes the following operations:

• Adding a License, page 5-3—Perform this workflow if you have purchased 
an initial or additional license and want to add it.

• Upgrading a License, page 5-4—Perform this workflow if you have already 
added a Restricted license and want to upgrade it to an Unrestricted license.

• Deregistering a License, page 5-7—Perform this workflow if you need to 
deregister a license.

Note Licenses (that is, the License Manager) must reside on a host that is accessible to 
the component program at startup. This can be the local host where the component 
program is installed or a remote host. For more information about licensing 
options, see the “Product Licensing” section on page 1-5.
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Using the License Manager
You can see which licenses and license servers are installed on your network by 
using the License Manager. You can also perform license operations from the 
License Manager using the following procedure.

Step 1 Log on to a computer that has at least one of the following programs installed:

• Cisco Application Analysis

• Cisco Audit and Analysis

• Cisco Audit and Analysis–SP

• Cisco Design and Analysis

• Cisco Design and Analysis–SP

Step 2 Start the License Manager for the installed program. On a Windows host, for 
example, you might see the following shortcut:

Start > Programs > Cisco Design and Analysis 12.0 > License Manager

Step 3 In the License Manager, select the license(s) or license server you want to act on, 
then click on the correct operation button on the right.

Note The License Manager might show some child windows that prompt you 
for additional information, such as which product modules to use. You do 
not need to specify these options to use the License Manager; generally 
you can click OK to accept the default settings and close the child 
window.

License Names
License names in the License Manager differ from the Cisco component names. 
The following table shows the component names and the license names that 
appear for each component.
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Adding a License
Table 5-2 shows the workflow for adding your licenses.

Obtaining a Username and Password
To add a license, you must have a valid username, password, and group ID. To 
obtain this information, you must register your Cisco VNDS product with Cisco 
Systems, Inc. Instructions for doing this are listed on the Software License Claim 
Certificate that is included in your product installation package. For more 
information, see the “Registering Your Cisco Solution Product” section on 
page 1-3.

Table 5-1 Cisco Product Component Names and License Names

Cisco Component Name License Name

Virtual Network Data Server VNE Server

Table 5-2 Adding a License: Workflow

Description Reference
Step 1 Obtain a username and password (if you 

have not done so already)
Obtaining a Username and Password, page 5-3

Step 2 Add program license(s) using one of the 
following methods for each license:

• Express method Adding a License (Express Method), page 5-8

• Browser method (if Express method 
does not work)

Adding a License (Browser Method), page 5-9

Contact Cisco Technical Support (if 
Express and Browser methods do not 
work)

Technical Support for Licensing Operations, 
page 5-15

Note You must repeat the Add License procedure for every computer on which you want to 
add a license. In this case, you must do the add-license operation twice—once for each 
computer.
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After your registration is confirmed, Cisco will send you an email with a 
username, password, and Group ID number. You will need this information when 
you add the component licenses as described in the following sections.

After you obtain a username and password, you can add your licenses as described 
in the “Adding a Component License (Express Method)” procedure on page 5-8 
or the “Adding a Component License (Browser Method)” procedure on page 5-10.

Upgrading a License
Table 5-3 shows the workflow for upgrading your licenses. For information about 
different grades of licenses, see the “Product Licensing” section on page 1-5.

Table 5-3 Upgrading a License: Workflow

Description Reference
Step 1 Obtain an Upgrade authorization from Cisco 

Systems, Inc.
Getting an Upgrade Authorization from 
Cisco Systems, Inc., page 5-5

Step 2 Deregister the original (Restricted) license 
using one of the following methods:

• Express method Deregistering a License (Express Method), 
page 5-12

• Browser method (if Express method does 
not work)

Deregistering a License (Browser Method), 
page 5-13

• Contact Cisco Technical Support (if 
Express and Browser methods do not work)

Technical Support for Licensing 
Operations, page 5-15
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Getting an Upgrade Authorization from Cisco Systems, Inc.
Before you can upgrade a Cisco Solution license, you must obtain an 
authorization from Cisco Systems, Inc. To obtain an authorization, do the 
following:

Step 1 Go to the following URL:

http://www.opnet.com/support/cisco_qsp.html

Step 2 Follow the My PAKS link to see the Product Authorization Keys you have added 
already. Note the PAK of the product that you want to upgrade from Restricted to 
Unrestricted.

Step 3 Go to one of the URLs listed in the“Registration Information” section on 
page 1-4. 

Step 4 Follow the instructions on the Cisco licensing page. You must submit the Product 
Authorization Key for both the new license and the original license that you want 
to upgrade. 

Step 3 Add the upgraded (Unrestricted) version of the 
original license using one of the following 
methods:

• Express method Adding a License (Express Method), 
page 5-8

• Browser method Adding a License (Browser Method), 
page 5-9

• Contact Cisco Technical Support (if 
Express and Browser methods do not work)

Technical Support for Licensing 
Operations, page 5-15

Note You must perform both procedures—that is, deregister the Restricted license and add 
the Unrestricted license—before you can use Unrestricted licensing mode. Also, keep 
in mind that after you deregister your current (Restricted) license, you will be unable 
to use the software until you register the updated (Unrestricted) license.

Table 5-3 Upgrading a License: Workflow (continued)

Description Reference

http://www.opnet.com/support/cisco_qsp.html
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After you submit the requested information, Cisco Systems will email you an 
authorization to proceed with the upgrade (go to Step 2 of Upgrading a License, 
page 5-4). 

Adding a Module to the Product Options List
After you add a license for a product module, you must update your Product 
Options list so that the program requests the module license on startup.

Adding a Module to the Product Options List

Step 1 Start the program to which the product module applies.

Step 2 In the main program window, choose License > Product Modules.

Step 3 In the Select Product Modules, select the checkbox for the module you have 
added. Then click OK.

Step 4 For the change to take effect, you must exit and restart the program.
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Deregistering a License
Table 5-4 shows the workflow for deregistering licenses. 

Refreshing a License
After installing an update to the Cisco Virtual Network Data Server software, you 
must refresh your licenses by contacting Cisco Systems as described in the 
“Technical Support for Licensing Operations” section on page 5-15.

Table 5-4 Deregistering a License: Workflow

Description Reference
Step 1 Deregister a program license(s) using one 

of the following methods for each license:

• Express method Deregistering a License (Express Method), 
page 5-12

• Browser method (if Express method 
does not work)

Deregistering a License (Browser Method), 
page 5-13

Contact Cisco Technical Support (if 
Express and Browser methods do not work)

Technical Support for Licensing Operations, 
page 5-15
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License Operations

Adding a License (Express Method)
The following procedure is the quickest and easiest way to add a license. This 
method requires that your computer be able to communicate directly with the 
Cisco Solutions license-registration server over the Internet, either directly or 
using a proxy server.

Note The Express method can fail due to firewall restrictions, socket or proxy errors, 
or transaction time-outs. If you cannot add the license using this method, try the 
Browser method (as described in Adding a License (Browser Method), page 5-9).

Adding a Component License (Express Method)

Step 1 Log on to a computer that has at least one of the following programs installed:

• Cisco Application Analysis

• Cisco Audit and Analysis

• Cisco Audit and Analysis–SP

• Cisco Design and Analysis

• Cisco Design and Analysis–SP

Step 2 Start the License Manager for the installed program. On a Windows host, for 
example, you might see the following shortcut:

Start > Programs > Cisco Design and Analysis 12.0 > License Manager

Step 3 In the License Manager, click on the green dot that represents the license server 
on the computer where you want to add the license. (The license server computer 
might not be the same as your local computer.) 

Click on the Add License button on the right side of the box.

Step 4 When prompted to select the transaction method, click Express. This method is 
easiest and fastest.
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Step 5 Enter the Username, Password, and Group ID that you received when you 
registered your product with Cisco Systems, Inc. (as described in the “Obtaining 
a Username and Password” section on page 5-3).

Step 6 If the computer uses a proxy server, click on Specify Proxy button and fill in the 
information.

Step 7 The next screen shows a list of available licenses. To select one license, click on 
it. To select multiple licenses, control-click or drag on the licenses. 

Note Select only the licenses you want to add to the computer of the license 
server you have selected. (If you also want to add other licenses to a 
different computer, you must repeat this procedure for that computer.)

Step 8 After you select the licenses you want to add, click on the Add License button at 
the bottom. A progress window might appear while the license is added to your 
computer. A window should then appear and say that the license operation 
succeeded. 

Step 9 When the operation is complete, the Select Product Modules box might appear. 
This allows you to select the modules you want to use. (In most cases, you should 
select all available modules.)

Step 10 To start using the program, exit the License Manager and start the program.

Adding a License (Browser Method)
Before using the Browser method, try the Express method. With the Express 
method, there is no need to exchange codes and you can add many licenses to your 
computer in one operation. Use this procedure if the Express method fails or you 
prefer to use the Browser method.

Note If you still cannot add your licenses using this method, see the “Technical Support 
for Licensing Operations” section on page 5-15.
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Adding a Component License (Browser Method)

Step 1 Log on to a computer that has at least one of the following programs installed:

• Cisco Application Analysis

• Cisco Audit and Analysis

• Cisco Audit and Analysis–SP

• Cisco Design and Analysis

• Cisco Design and Analysis–SP

Step 2 Start the License Manager for the installed program. On a Windows host, for 
example, you might see the following shortcut:

Start > Programs > Cisco Design and Analysis 12.0 > License Manager

Step 3 License Manager: Click on the green dot that represents the license server on the 
computer where you want to add the license. (The license server computer might 
not be the same as your local computer.) 

Click Add License on the right side of the window.

Step 4 License Manager: When prompted, click Browser. The following events should 
now occur:

• The License Manager launches your Web browser and points it to the Cisco 
Solutions Quick Support Page.

• The License Manager shows a transaction code and a hostname.

Step 5 Web browser: Enter the Username and Password that you received when you 
registered your product with Cisco Systems, Inc. (as described in the “Obtaining 
a Username and Password” section on page 5-3).

If your browser fails to launch, start it manually and navigate to the following 
URL:

http://www.opnet.com/support/cisco_qsp.html

Then follow the My Licenses link in the browser window.

Step 6 Web browser: Click Perform license operations, then select Add License 
(add_permits) and click Next. Back in the License Manager, a dialog box 
containing a Transaction Code and Hostname field should appear.

http://www.opnet.com/support/cisco_qsp.html
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Step 7 Web browser: Copy the Transaction Code and Hostname from the License 
Manager into the corresponding fields in the browser. You can either copy/paste 
the text or type it manually. 

Note Make sure there are no extra spaces before or after the code or hostname.

Step 8 Web browser: Click Next. 

Step 9 Web browser: When the Select the starting license number page appears, select 
the lowest license ID that you want to add to your computer. If you want to add 
only one license, select that license.

Step 10 Web browser: When the Select the ending license number page appears, select the 
highest license ID that you want to add to your computer. If you want to add only 
one license, select that license. The confirmation page appears.

Step 11 Web browser: When the License Registration Confirmation page appears, check 
that the information is correct, then click Get Approval Code. The approval code 
appears.

Step 12 License Manager: Click Next and enter the approval code that appears in the web 
browser. 

Note This code can be very long, so make sure you copy the entire approval 
code. 

Step 13 License Manager: After you enter the approval code, click Next.

Step 14 License Manager: If the Select Product Modules license window appears, click 
OK. Then click File > Exit to close the License Manager.

Step 15 To start using the program, exit the License Manager and start the program.
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Deregistering a License (Express Method)
The following procedure is the quickest and easiest way to deregister a license. 
This method requires that your computer be able to communicate directly with the 
Cisco Solutions license-registration server over the Internet, either directly or 
using a proxy server.

Note The Express method can fail due to firewall restrictions, socket or proxy errors, 
or transaction time-outs. If you cannot deregister the license using this method, 
try the Browser method (as described in the “Deregistering a License (Browser 
Method)” section on page 5-13).

Deregistering a Component License (Express Method)

Step 1 Log on to a computer that has at least one of the following programs installed:

• Cisco Application Analysis

• Cisco Audit and Analysis

• Cisco Audit and Analysis–SP

• Cisco Design and Analysis

• Cisco Design and Analysis–SP

Step 2 Start the License Manager for the installed program. On a Windows host, for 
example, you might see the following shortcut:

Start > Programs > Cisco Design and Analysis 12.0 > License Manager

Step 3 In the License Manager, expand the license file by clicking on the + sign next to 
the License file folder icon. Make sure the license you want to deregister is 
available (green).

Note If a license is represented by a “white page” icon, that license is currently 
in use. If you want to deregister a license that is in use, quit the component 
that is using it, then choose File > Refresh Server Information in the 
License Manager.
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Step 4 Select the license you want to deregister by clicking on it. To select one license, 
click on it. To select multiple licenses, control-click or drag on the licenses. 

Step 5 Click Deregister License on the right side of the License Manager window.

Step 6 When prompted to select the transaction method, click Express. This method is 
easiest and fastest.

Step 7 When the Authentication window appears, enter your Username, Password, and 
Group ID in the appropriate fields.

Step 8  If the computer uses a proxy server, click Specify Proxy; when the Specify proxy 
server information window appears, fill in the requested information and click 
OK. 

Step 9 Click OK in the Authentication window. 

• A progress window might appear while the license is deregistered from your 
computer. 

• A window should then appear to indicate that the operation succeeded.

Deregistering a License (Browser Method)
Before using the Browser method, try the Express method. With the Express 
method, there is no need to exchange codes and you can add many licenses to your 
computer in one operation. Use this procedure if the Express method fails or you 
prefer to use the Browser method.

Note If you still cannot deregister your licenses using this method, see the “Technical 
Support for Licensing Operations” section on page 5-15.

Deregistering a Component License (Browser Method)

Step 1 Log on to a computer that has at least one of the following programs installed:

• Cisco Application Analysis

• Cisco Audit and Analysis

• Cisco Audit and Analysis–SP
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• Cisco Design and Analysis

• Cisco Design and Analysis–SP

Step 2 Start the License Manager for the installed program. On a Windows host, for 
example, you might see the following shortcut:

Start > Programs > Cisco Design and Analysis 12.0 > License Manager

Step 3 License Manager: Expand the appropriate license file by clicking on the + sign 
next to the License file folder icon. Make sure the license you want to deregister 
is available (green).

Note If a license is represented by a “white page” icon, that license is currently 
in use. If you want to deregister a license that is in use, quit the component 
that is using it, then choose File > Refresh Server Information in the 
License Manager.

Step 4 License Manager: Select the license you want to deregister by clicking on it. To 
select one license, click on it. To select multiple licenses, control-click or drag on 
the licenses. 

Step 5 License Manager: Click Deregister License.

Step 6 License Manager: When prompted, click on the Browser button.

Step 7 The License Manager launches your Web browser and points it to the Cisco Quick 
Support page. If your browser fails to launch, start it manually and navigate to the 
following URL: 

http://www.opnet.com/support/cisco_qsp.html

Step 8 Web browser: Log in with your Cisco Solution username and password. Then 
click on My Licenses.

Step 9 Web browser: Follow the Perform license operations link, then select Deregister 
License (delete_permits) and click Next.

Back in the License Manager, a dialog box containing a Transaction Code and 
Hostname field should appear.

Step 10 Web browser: Copy the Transaction Code and Hostname from the License 
Manager into the browser window, then click Next. You can either paste the text 
or type it manually. 

http://www.opnet.com/support/cisco_qsp.html
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Note Make sure there are no extra spaces before or after the text you enter.

Step 11 Web browser: When the Select the starting license number page appears, select 
the lowest license ID that you want to deregister from your computer. If you want 
to deregister only one license, select that license.

Step 12 Web browser: When the Select the ending license number page appears, select the 
highest license ID that you want to deregister from your computer. If you want to 
deregister only one license, select that license.

Step 13 Web browser: When the License Registration Confirmation page appears, check 
that the information is correct, then click Get Approval Code. The approval code 
appears.

Step 14 License Manager: Click Next and enter the approval code that appears in the 
browser. 

Note This code can be very long, so make sure you copy the entire approval 
code. 

Step 15 License Manager: Click Next. The confirmation code appears. 

Step 16 Web browser: Enter the confirmation code that appears in the License Manager, 
then click Next. 

The confirmation code is saved in the Session Log, which is available from the 
Help menu in the Cisco Solution software.

Step 17 License Manager: click Done. The license is deregistered and you can now add it 
to another computer. 

Technical Support for Licensing Operations
If you cannot manage your licenses using the Express or Browser methods, or if 
you have additional questions or problems regarding your licenses, you can do the 
following:

• Go to the Cisco Solutions Quick Support Page:
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http://www.opnet.com/support/cisco_qsp.html 

• Contact Cisco Systems as described in the “Obtaining Technical Assistance” 
section on page fm-viii

http://www.opnet.com/support/cisco_qsp.html)
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6
Uninstalling 
Cisco Virtual Network Data Server

Use the procedures in this chapter to uninstall Cisco VNDS:

• Removing VNDS Database Contents (Optional), page 6-1

• Uninstalling Cisco VNDS (Windows), page 6-3

• Uninstalling Cisco VNDS (Linux), page 6-8

• Uninstalling a License Server, page 6-9

Removing VNDS Database Contents (Optional)
If you want to completely remove the tablespace files and user account for 
Cisco VNDS 4.0 from a local database, perform Removing Cisco VNDS 
Database Contents, page 6-2. You do not need to perform this procedure if you 
are updating the Cisco VNDS installation.

Warning Perform this procedure only if you are permanently removing Cisco VNDS 
from a system AND want to remove database contents as well as the product 
installation. 

Note If you choose to perform this procedure, you must do it before you remove the 
Cisco VNDS installation.

6
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Removing Cisco VNDS Database Contents 

Step 1 Log into the Cisco VNDS host using an account with administrator and 
ORA_DBA privileges.

Step 2 Stop services and exit the Control Panel.

Step 3 Open a command window and use the cd command to set the working directory 
to the Cisco VNDS installation directory. An example installation directory might 
be: 

• Windows: C:\Cisco\VNDServer\4.0.2_<build_number>

• Linux: /opt/cisco/VNDServer/4.0.2_<build_number>

Step 4 Stop all VNDS background services/daemons by entering the following 
command:

• Windows: vnes.bat /svc_cmd stop ALL 

• Linux: vnes.sh -c stop ALL 

Step 5 Type: sqlplus system/<password>

A Connected to: Oracle banner message appears if you succeed in logging into 
Oracle.

Step 6 To get a list of database instance names, type: select name from v$database;

A list (probably just one item) of database names known to Oracle appears. If 
more than one name appears, work with your DBA to identify which one is used 
for Cisco VNDS.

Step 7 While still in sqlplus, type: @drop_accounts.sql <dbname>

where the <dbname> is the one identified in the previous step.

• Progress messages appear as the user account and tablespace files are deleted.

• When done, the database instance still exists, but the tables and account used 
by Cisco VNDS no longer exist.

Note ALL network project data written to the database by Cisco VNDS is 
deleted by this procedure.
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Uninstalling Cisco VNDS (Windows)
This section includes the procedures described in the following table.

Use the “Uninstalling Cisco VNDS on Windows (Standard)” procedure on 
page 6-3 to uninstall the current release. If you wish to completely remove all 
traces of the current release from a machine, first perform “Uninstalling 
Cisco VNDS on Windows (Standard)” procedure on page 6-3 then continue on to 
“Removing All VNDS Elements (Advanced)” procedure on page 6-5.

To uninstall VNDS 1.1 after you update to the current release, perform 
“Removing Prior Cisco VNDS Release After Software Update” procedure on 
page 6-7.

Uninstalling Cisco VNDS on Windows (Standard)
Perform the following procedure to remove the VNDS 4.0 software from your 
computer.

Step 1 Log into the Cisco VNDS host using an account with administrator privileges.

Step 2 Stop services and exit the Control Panel.

Procedure Description

Uninstalling Cisco VNDS on Windows 
(Standard), page 6-3

Procedure for uninstalling Cisco VNDS 4.0.

Removing All VNDS Elements 
(Advanced), page 6-5

Procedure for removing residual elements of the VNDS 4.0 
installation (such as top-level Windows Registry keys and 
Program Group shortcuts). 

Perform this procedure ONLY if you need to completely 
remove everything installed or generated by Cisco VNDS 
4.0.

Removing Prior Cisco VNDS Release 
After Software Update, page 6-7

Procedure for removing VNDS 3.5 following successful 
installation of Cisco VNDS 4.0 and migration of product 
configuration. 
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Step 3 Open a command window and use the cd command to set the working directory 
to the Cisco VNDS installation directory. An example installation directory might 
be: 

C:\Cisco\VNDServer\4.0.2_<build_number>

Step 4 Stop all VNDS background services by entering the following command:

Windows: vnes.bat /svc_cmd stop ALL

Step 5 Open the Windows Control Panel from the Start menu:

Start > Settings > Control Panel

Step 6 In the Windows Control Panel, double-click Add/Remove Programs.

Step 7 Scroll down the list of installed programs, select the entry for 
Cisco Virtual Network Data Server 4.0, and click Remove.

The Windows uninstaller removes the following items:

• Windows services

• Desktop shortcut

• Most Windows Registry entries

• Most Program Group shortcut entries

• Most of the installation directory

Step 8 Delete the remnants of the corresponding installation directory. For example, the 
installation directory might be:

C:\Cisco\VNDServer\4.0.2_<build_number> 

After you complete this procedure, the following remain:

• top-level Windows Registry entry for the release 

• top-level Program Group shortcut for the release 

• VND Server temporary directory

• VND Server archive directory

• Jre directory
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Removing All VNDS Elements (Advanced)
If you wish to completely remove all traces of Cisco Virtual Network Data Server 
4.0 from a machine, first perform “Uninstalling Cisco VNDS on Windows 
(Standard)” procedure on page 6-3 then use the “Removing All VNDS Elements 
(Advanced)” procedure on page 6-5 to remove residual components of the 
installation.

Note Perform this procedure ONLY if you need to completely remove everything 
installed or generated by Cisco Virtual Network Data Server 4.0.

Removing All Cisco VNDS Elements

Step 1 Perform “Uninstalling Cisco VNDS on Windows (Standard)” procedure on 
page 6-3 if you have not already done so.

Step 2 Log into the VND Server host using an account with administrator privileges.

Step 3 Delete the temporary directory. Typical temporary directory:

C:\op_admin\temp\vne 

Note If you have another VNDS release that you want to keep and it uses the 
same parent directory, skip this step.

Step 4 Delete the archive directory. Typical archive directory:

C:\op_admin\archive 

Note If you have another VNDS release that you want to keep and it uses the 
same archive directory, skip this step.

Step 5 Delete the Java Jre directory (if it remains). This directory is located under the 
parent install directory. Typical Jre directory:

C:\Cisco\Jre 
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Note If you have another VNDS release that you want to keep and it is installed 
to the same parent directory (for example C:\Cisco), skip this step. 
Otherwise, you'll remove the Jre used by a release you want to keep.

Step 6 Delete the top-level Program Group shortcut for the release. All users have a 
shortcut. Delete the Cisco Virtual Network Data Server 2.0 shortcut from:

C:\Documents and Settings\All Users\Start Menu\Programs 

Step 7 Start regedit: From the Windows Start menu, choose Run; then enter regedit and 
click OK.

Warning Be very careful when you edit the system registry. Incorrect changes to the 
registry can cause your Windows system to become unstable. You might 
want to create a backup before editing the registry.

Step 8 In the Windows Registry Editor, find and select the registry key for the software 
being removed. Example registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\OPNET Technologies\
Cisco VND Server 4.0.2 

Step 9 Select Delete from the menu to delete the entry.

Step 10 Verify that the uninstaller entry in the Registry has been removed. Remove the 
entry if it still exists in the Registry at the following location:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\

Uninstall 

Example entry:

Cisco Virtual Network Data Server 2.0

Step 11 Verify that any services installed by Virtual Network Data Server are gone. 
Remove the following services if they still exist in the Registry at the following 
location:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

-OPNETVNESxxx 

-OPNETVnesxxx 

Where xxx is AdapterServer, BootstrapService, etc.

Step 12 Exit the Windows Registry Editor.
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At this point, Cisco Virtual Network Data Server is completely removed from 
your system. 

Removing Prior Cisco VNDS Release After Software Update
Perform this procedure if you wish to remove Cisco Virtual Network Data Server 
3.5 after you have installed Cisco VNDS 4.0 and migrated your product 
configuration. 

If you want to remove Cisco VNDS 3.5 completely from a machine that has not 
been updated to the current release, Refer to the Installation Guide for Cisco 
Configuration Assurance Solution 1.1 or Network Planning Solution 1.1.

Note Do not run the Windows uninstaller for a previous VNDS release after you have 
updated to the current software release. Doing so may impact the current release.

Removing a Prior VNDS Release After Update

Step 1 Delete the VNDS 3.5 install directory. Typical default install directory:

C:\Cisco\CiscoCAS\VNEServer\3.5.2_<build_number> 

C:\Cisco\CiscoNPSSPM1.1\VNEServer\3.5.2_1107<build_number> 

Step 2 Delete the following VNDS Program Group shortcuts from the Program Group 
menu for the appropriate Cisco solution bundle (Cisco Configuration Assurance 
Solution, Cisco Network Planning Solution, etc.):

• Virtual Network Data Server 

• Open Virtual Network Data Server File Log Viewer 

Example Program Group menus for Cisco solution bundles:

C:\Documents and Settings\All Users\Start Menu\Programs\Cisco 
Configuration Assurance Solution 1.1 

C:\Documents and Settings\All Users\Start Menu\Programs\Cisco Network 
Planning Solution 1.1 - SPM

Step 3 If the Program Group menu for the appropriate Cisco solution bundle is now 
empty, delete the menu.
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Warning Be very careful when you edit the system registry. Incorrect changes to the 
registry can cause your Windows system to become unstable. You might 
want to create a backup before editing the registry.

Step 4 In the Windows Registry Editor, find and select the registry key for the software 
being removed. Example registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\OPNET Technologies\
Cisco Virtual Network Data Server 1.1\OPNET VNE Server 3.5.2.

Step 5 Select Delete from the menu to delete the entry.

Step 6 Remove the uninstaller entry in the Registry at the following location:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Uninstall

Example entry names:

Cisco Virtual Network Data Server 1.1 Virtual Network Data Server 

Cisco Virtual Network Data Server 1.1 - Service Provider Module - 
Virtual Network Data Server

Step 7 Exit the Windows Registry Editor.

Uninstalling Cisco VNDS (Linux)
Perform the following procedure to remove the VNDS software from your 
computer.

Step 1 Stop services and exit the Control Panel.

Step 2 Open a command window and use the cd command to set the working directory 
to the VNDS installation directory. An example installation directory might be: 

/opt/cisco/VNDServer/4.0.2_<build_number> 

Step 3 Enter the following command:

./vnes.sh -c stop ALL 

Step 4 Close the window or cd up one level.

Step 5 Enter the following command:

rm -rf <vnds_install>
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where <install_path> is the VNDS installation directory. 

Step 6 At this point, there are still some daemon scripts remaining in the /etc directory. 
Removing these scripts is optional. To remove these scripts, open a command 
window and enter the following commands: 

cd /etc/init.d 

run "rm OPNET*" 

run "rm tomcat.sh" 

run "rm vnetomcat.sh" 

Uninstalling a License Server
This section describes how to uninstall a license server from the Cisco VNDS 
host. 

Note In previous versions of Cisco VNDS, a license server that was installed with the 
software was uninstalled with the Cisco VNDS software. If you installed a local 
license server with Cisco VNDS 3.5, refer to the Installation Guide for the 
previous release. 

If you installed a local license server with Cisco VNDS 4.0, use the following 
procedure to remove it. 

Uninstalling License Server (Windows)

Warning Do not uninstall the license server until another license server can be set up 
elsewhere. You must deregister licenses and move them to the new license 
server then redirect all impacted solution components to the new license 
server before you uninstall the old license server. 

Step 1 Deregister all active licenses for the license server. Use the “Deregistering a 
License” procedure on page 5-7.

Step 2 Open the Windows Control Panel from the Start menu:
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Start > Settings > Control Panel

Step 3 In the Windows Control Panel, double-click Add/Remove Programs.

Step 4 Scroll down the list of installed programs, select the entry for OPNET License 
Server 12.0, and click Remove.

Step 5 (Optional) Remove the license directory (for example, C:\OPNET_license dir).

Warning Be very careful when you edit the system registry. Incorrect changes to the 
registry can cause your Windows system to become unstable. You might 
want to create a backup before editing the registry.

Step 6 (Optional) Verify that the registry key has been removed. In the Windows Registry 
Editor, find and select the registry key for the software being removed. Example 
registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\OPNET Technologies\
OPNET License Server 12.0\12.0.A 

If the entry exists, select Delete from the menu to remove it.

Uninstalling License Server (Linux)

Warning Do not uninstall the license server until another license server can be set up 
elsewhere. You must deregister licenses and move them to the new license 
server then redirect all impacted solution components to the new license 
server before you uninstall the old license server. 

Step 1 Deregister all active licenses for the license server. 

Step 2 Open a command window and use the cd command to set the working directory 
to the license server installation directory (for example, 
/usr/bin/OPNET/12.0.A/).

Step 3 Enter the following command to delete the contents of the license server 
installation directory:

rm -rf * 

Step 4 Remove the startup folder by entering the following command:

rm /etc/rc3.d/S99opnet_lic_server 
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Step 5 (Optional) Remove the license directory.
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A P P E N D I X A
Oracle Procedures (Windows)

This appendix includes a series of procedures for installing Oracle software for 
use with Cisco Virtual Network Data Server. For information about when to 
perform each procedure, see the “Installation Workflows” section on page 3-2.

Note The instructions in this appendix are included for the convenience of Cisco VNDS 
users. For detailed information about using Oracle products, consult the Oracle 
product documentation or Oracle technical support.

Oracle9i Installation Procedures

Installing the Oracle9i Database (Windows)

Warning Use caution when installing Oracle for use with VNDS. Recovery is difficult 
if Oracle is incorrectly installed. 

You can install the Oracle database on the same host as VNDS or on a different 
host. Install the database on the appropriate host using Installing the Oracle 9i 
Database on Windows, page A-2.
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Installing the Oracle 9i Database on Windows

Step 1 Log into the host as Administrator or as a user with full administrative privileges. 
If you are not logged in with the proper privileges, log off and log on with an 
appropriate account.

Step 2 Insert the Oracle installation CD into the CD drive of the host for the database. If 
the installer does not start automatically, use Start > Run to execute Oracle’s 
setup.exe program. 

The installer displays a Welcome panel. 

Step 3 Press Next to proceed to the File Locations panel. 

The installer prompts you for an installation path in the File Locations panel. 
Oracle (9.2.0.1.0) requires about 2.8 GB of disk space. 

Step 4 Enter an installation path that resides on a disk with adequate free space. Press 
Next to proceed. 

The installer prompts you for the Oracle product to install in the Available 
Products panel. 

Step 5 Select the Oracle9i Database product. Press Next to proceed. 

The installer prompts you for the type of installation in the Installation Types 
panel. 

Step 6 Select a Personal, Standard, or Enterprise edition installation. Any of these 
editions can be used with VNDS. The Enterprise edition is recommended for best 
scalability and performance. 

Step 7 Press Next to proceed. 

The installer prompts you for the type of database in the Database 
Configuration panel. 

Step 8 Select General Purpose. Press Next to proceed. 

The installer prompts you for the port number for the Oracle MTS Recovery 
Service. 

Step 9 Leave the default port number (2030) unchanged. Press Next to proceed. 

The installer prompts you for a global database name (GDN) in the Database 
Identification panel.

VNDS will work with any valid GDN and SID that Oracle accepts. 

Answer with a GDN constructed according to the following rules:
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Global Database Name = o92a<name>.<domain>.com

An example: o92avnes.opnet.com 

Note If the first portion of the GDN exceeds 8 characters, the Oracle installer 
will block installation. 

The installer prompts you for a system ID (SID). Some examples follow:

• o92a 

• o92avnes

• vnesDB

Step 10 Enter the SID you want to use. After entering a GDN and SID, press Next to 
continue to the Database File Location panel. 

The installer prompts you for the Database File Location. 

Step 11 Keep the default location and press Next to proceed. 

The installer prompts you for the Database Character Set. 

Note To view the list of supported Oracle database and national character sets 
for use with VNDS, refer to Cisco Virtual Network Data Server: System 
Requirements, page 2-1. Choose a supported character set and press Next 
to proceed with file installation. 

The Oracle installer takes up to 30 minutes to copy files to the installation 
directories. Oracle9i has three installation CDs. The installer prompts you to 
insert a new CD in the CD drive when it is ready to copy files from the next CD. 

During this time, Install, Configuration Tools and Database Creation 
panels appear. 

Step 12 Press Next or OK to proceed through these panels. 

Note A window titled HTTP Server may launch at this point. You can close this 
window.

An installation Summary panel appears. 
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Step 13 Press Install to proceed. 

The Database Configuration Assistant prompts you for new passwords for the 
SYS and SYSTEM accounts. 

Step 14 Enter the passwords that you want to use for these accounts, and press OK when 
done. 

Step 15 When installation is complete, an End of Installation panel appears. Press Exit 
to close the Oracle installer.

Note You do not need to create a user account for VNDS at this time. This is 
done after VNDS installation. 

Step 16 Record the Oracle GDN, SID, install path and database hostname in Table A-1 on 
page A-14.

Installation logs are located here:

C:\Program Files\Oracle\Inventory\logs\installActions.log

If you run the Oracle installer again, the install actions log is renamed with an 
embedded date-stamped name such as: installActions2002-01-24_xxx. 

Oracle9i (9.2.0.1.0) installation is now complete. 

After VNDS is installed, a final configuration step is required to finish Oracle 
setup for VNDS. This step is described in “Configuring the Oracle Database for 
Cisco VNDS (Windows)” section on page 3-17, but is not performed until after 
installation of VNDS. 

Proceed at this time to “Oracle9i Installation Procedures” section on page A-1 and 
then to “Installing Cisco VNDS (Windows)” section on page 3-6.

Note About Oracle Services

After Oracle installation, several Windows services are created. VNDS only 
requires the Oracle services shown below. These Windows services should be 
configured to automatically start when the PC is booted. All other Oracle services 
may be configured for a manual start and stopped unless specifically needed for 
other uses. The following services are required for VNDS to run:

• OracleOraHome92TNSListener 
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• OracleService<DB SID>

Installing the Oracle9i Client (Windows)

Warning Use caution when installing Oracle for use with VNDS. Recovery is difficult 
if Oracle is incorrectly installed. 

If the Oracle database is installed on a different machine that the VNDS software, 
you must install the Oracle client on the VNDS host. The Oracle client is required 
by VNDS to communicate with an Oracle database located on another host. 
Perform “Installing the Oracle 9i Client on Windows” section on page A-5 to 
install the Oracle 9i client.

Installing the Oracle 9i Client on Windows

Step 1 Log into the host as Administrator or as a user with full administrative privileges. 
If you are not logged in with the proper privileges, log off and log on with an 
appropriate account.

Step 2 Insert the Oracle installation CD into the CD drive of the host for VNDS. If the 
installer does not start automatically, use Start > Run to execute Oracle’s 
setup.exe program. 

The installer displays a Welcome panel. 

Step 3 Press Next to proceed to the File Locations panel. 

The installer prompts you for an installation path in the File Locations panel. 
Oracle Client (9.2.0.1.0) requires about 200 MB of disk space. 

Step 4 Enter an installation path that resides on a disk with adequate free space. Press 
Next to proceed. 

The installer prompts you for the Oracle product to install. 

Step 5 Select the Oracle9i Client product. Press Next to proceed. 

The installer prompts you for the type of installation in the Installation Types 
panel.

Step 6 Select Runtime. Press Next to proceed to the Summary panel. 

An installation Summary panel appears. 
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Step 7 Press Install at this panel to begin Oracle installation. The Oracle installer takes 
up to 30 minutes to copy files to the installation directories. 

Note The final installation tasks involve setting up Net services using the Net 
Configuration Assistant. 

Step 8 Press Next at the Configuration Tools panel. 

The installer prompts you for whether you want to use a directory service at the 
Net Configuration Assistant panel. 

Step 9 Select No, and press Next. 

The installer prompts you for the version of Oracle used by the database at the 
Database Version panel. 

Step 10 Select Oracle 8i or later database, and press Next. 

The installer prompts you for a database service name at the Service Name panel. 

Step 11 Enter the Global Database Name used during Oracle database installation on the 
database host. This name should be the same as the Database TNS Service Name 
collected in Table A-1 on page A-14. Press Next. 

The installer prompts you for the communication protocol to use at the Select 
Protocols panel.

Step 12 Select the appropriate protocol to use (e.g. TCP), and press Next. 

The installer prompts you for the database host name. 

Step 13 Enter the hostname as an IP address or a fully qualified domain name, and press 
Next. 

The installer prompts you for whether you want to test the database connection. 

Step 14 Answer Yes, and press Next. 

The installer displays the test status in a test result panel. 

Step 15 Press Next. 

Note Investigate and resolve any problems if the connection test fails. 

The installer prompts you for whether or not you want to configure another 
service name. 
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Step 16 Answer No, and press Next. 

A Configuration Complete panel appears. 

Step 17 Press Next. 

Another completion panel appears. 

Step 18 Press Finish. 

The installer displays an End of Installation panel. 

Step 19 Press Exit to close the Oracle installer.

Installation logs are located here: 

C:\Program Files\Oracle\Inventory\logs\installActions.log 

If you run the Oracle installer again, the install actions log is renamed with an 
embedded date-stamped name such as: installActions2002-01-24_xxx. 

Proceed at this time to Oracle9i Installation Procedures, page A-1, and then to 
Installing Cisco VNDS (Windows), page 3-6. 

Oracle10g Installation Procedures

Installing the Oracle10g Database (Windows)

Warning Use caution when installing Oracle for use with VNDS. Recovery is difficult 
if Oracle is incorrectly installed. 

You can install the Oracle database on the same host as VNDS or on a different 
host. Install the database on the appropriate host using Installing the Oracle 10g 
Database (Windows), page A-8.

Note Oracle10g requires a static IP address on the database host machine. If the 
database host has a dynamically assigned IP address, install the Microsoft 
Loopback Adapter before you install Oracle10g.
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Installing the Oracle 10g Database (Windows)

Step 1 Log into the host as Administrator or as a user with full administrative privileges. 
If you are not logged in with the proper privileges, log off and log on with an 
appropriate account.

Step 2 Insert the Oracle installation CD into the CD drive of the host for the database. If 
the installer does not start automatically, use Start > Run to execute Oracle’s 
setup.exe program. 

The installer displays an Installation Method panel. 

Step 3 Select Basic Installation in the Installation Method panel and enter values for 
Basic Installation configuration. 

a. Enter an installation path into the Oracle Home Location field. Make sure 
that it resides on a disk with adequate free space.

Oracle (10.2.0.1.0) requires about 2.8 GB of space.

b. Select the Installation Type.

Select a Personal, Standard, or Enterprise edition installation. Any of these 
editions can be used with VNDS. The Enterprise edition is recommended for 
best scalability and performance. 

c. Make sure that Create Starter Database is selected.

d. Specify the Global Database Name (GDN).

VNDS will work with any valid GDN that Oracle accepts. 

Enter a GDN constructed according to the following rules:

Global Database Name = <database_name>.<database_domain> where 
<database_domain> is optional.

Some examples:

o10gvnes

vnes

vnes.opnet.com 

e. Type the password that will be used for the SYS, SYSTEM, SYSMAN, and 
DBSNMP accounts into the Database Password and Confirm Password fields.

f. Press Next to proceed. 

Step 4 A progress dialog displays while Oracle runs system verification checks.



A-9
Installation Guide for Cisco Virtual Network Data Server

OL-11599-01

Appendix A       Oracle Procedures (Windows)
    Oracle10g Installation Procedures

The Product-Specific Prerequisite Checks panel displays. 

Step 5 Review the results of the prerequisite checks and resolve errors and warnings 
before proceeding. 

Step 6 Press Next to proceed.

A Summary panel displays. 

Step 7 Press Install to proceed with installation. 

An Install panel displays progress. 

Next a Configuration Assistants panel displays progress.

A Database Configuration Assistant dialog notifies you when database 
creation is complete.

Step 8 Record the Oracle GDN, SID, install path and database hostname in Table A-1 on 
page A-14. 

You do not need to do any account or password management at this time. Creation 
of the VNDS account is done after VNDS installation. 

Step 9 Press OK in the Database Configuration Assistant dialog to continue.

When configuration is complete, an End of Installation panel displays. 

Step 10 Press Exit to close the Oracle installer.

Note A web browser with the Oracle Enterprise Manager may open. You can 
close this window.

Installation logs are located here:

C:\Program Files\Oracle\Inventory\logs\installActions.log 

If you run the Oracle installer again, the install actions log is renamed with an 
embedded datestamped name such as: installActions<date_time>.log. 

Oracle10g (10.2.0.1.0) installation is now complete. 

After VNDS is installed, a final configuration step is required to finish Oracle 
setup for VNDS. This step is described at “Configuring the Oracle Database for 
Cisco VNDS (Windows)” section on page 3-17, but is not performed until after 
installation of VNDS. 
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Proceed at this time to Oracle9i Installation Procedures, page A-1 and then to 
Installing Cisco VNDS (Windows), page 3-6.

Installing the Oracle10g Client (Windows)

Warning Use caution when installing Oracle for use with VNDS. Recovery is difficult 
if Oracle is incorrectly installed. 

If the Oracle database is installed on a different machine that the VNDS software, 
you must install the Oracle client on the VNDS host. The Oracle client is required 
by VNDS to communicate with an Oracle database located on another host. 
Perform Installing the Oracle 10g Client (Windows), page A-10 to install the 
Oracle 10g client.

Installing the Oracle 10g Client (Windows)

Step 1 Log into the host as Administrator or as a user with full administrative privileges. 
If you are not logged in with the proper privileges, log off and log on with an 
appropriate account.

Step 2 Insert the Oracle installation CD into the CD drive of the host for VNDS. If the 
installer does not start automatically, use Start > Run to execute Oracle’s 
setup.exe program. 

The installer displays a Welcome panel. 

Step 3 Press Next to proceed to the Installation Type panel. 

The installer prompts you for the type of client installation. 

Step 4 Select Runtime then press Next. 

The installer displays the Specify Home Details panel. 

Step 5 Specify the Path. 

Oracle Runtime Client (10.2.0.1.0) requires about 213 MB of disk space. 

Note Do not modify the Name field in the Specify Home Details panel. Use the 
value that the Oracle installer provides.
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Step 6 Enter an installation path that resides on a disk with adequate free space. Press 
Next to proceed. 

The Oracle installer performs prerequisite checks then displays the results in the 
Product-Specific Prerequisite Checks panel. 

Step 7 Press Next to proceed. 

The Summary panel displays.

Step 8 Press Install at this panel to begin Oracle installation. The Oracle installer takes 
several minutes to copy files to the installation directories. 

The Install panel displays progress then the Configuration Assistants panel 
displays. 

After a moment, the Oracle Net Configuration Assistant: Welcome dialog 
displays.

Step 9 Press Next.

The Oracle Net Configuration Assistant: Done dialog displays. 

Step 10 Press Finish. 

Step 11 The End of Installation panel displays. 

Step 12 Press Exit.

Note The final installation tasks involve setting up Net services using the 
Oracle Net Configuration Assistant. 

Step 13 Select Programs > Oracle - Oracle - OraClient10g_home1 > 
Configuration and Migration Tools > Net Configuration Assistant from the 
Windows Start menu. 

The Oracle Net Configuration Assistant opens and prompts you to choose the 
configuration you would like to do at the Welcome panel.

Step 14 Select Local Net Service Name configuration and press Next. 

The Oracle Net Configuration Assistant opens and prompts you to specify an 
action at the Net Service Name Configuration panel.

Step 15 Select Add then press Next.

The Oracle Net Configuration Assistant prompts you for a database service name 
at the Net Service Name Configuration, Service Name panel. 
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Step 16 Enter the Global Database Name used during Oracle database installation on the 
database host. This name should be the same as the Database TNS Service Name 
collected in Table A-1 on page A-14. Press Next. 

The Oracle Net Configuration Assistant prompts you for the communication 
protocol to use at the Net Service Name Configuration, Select Protocols 
panel.

Step 17 Select the appropriate protocol to use (e.g. TCP), and press Next. 

The Oracle Net Configuration Assistant prompts you for the database host name 
and TCP/IP port number.

Step 18 Enter the hostname as an IP address or a fully qualified domain name, and press 
Next. 

The Oracle Net Configuration Assistant prompts you for whether you want to test 
the database connection. 

Step 19 Answer Yes, and press Next. 

The test status displays.

Note Investigate and resolve any problems if the connection test fails. If the test 
did not succeed, make sure that the username and password is valid for 
the VNDS account that has been configured on the remote database. 
Change the login, if required, and retest. 

Step 20 Press Next.

The Oracle Net Configuration Assistant prompts you for a net service name. 

Step 21 Leave the Net Service Name set to the global database name for the remote 
database and press Next.

The Oracle Net Configuration Assistant prompts you for whether or not you want 
to configure another service name. 

Step 22 Answer No, and press Next. 

A Net Service Name Configuration panel displays. 

Step 23 Press Next. 

The Welcome panel displays. 

Step 24 Press Finish to close the Oracle Net Configuration Assistant. 
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Step 25 Verify that a tnsnames.ora file has been created for the database client. 

Look in <oracle_home>\client_1\NETWORK\ADMIN directory (for example, 
C:\oracle\product\10.2.0\client_1\NETWORK\ADMIN). 

Installation logs are located here: 

C:\Program Files\Oracle\Inventory\logs\installActions.log 

If you run the Oracle installer again, the install actions log is renamed with an 
embedded date-stamped name such as: installActions<date_time>.log. 

Now proceed to the following procedures.

For VNDS on Windows: 

a. Oracle9i Installation Procedures, page A-1

b. Installing Cisco VNDS (Windows), page 3-6. 

For VNDS on Linux: 

a. Collecting Oracle Database Access Information (Linux), page B-3

b. Installing Cisco VNDS (Linux), page 4-4. 

Collecting Oracle Database Access Information 
(Windows)

The VNDS installer prompts for database access information. Before beginning 
installation, collect the database access information listed in Table A-1 on 
page A-14. The database administrator can supply the database access 
information that you need. Print out the installation instructions and write down 
the database access information in the Table A-1 on page A-14 for reference 
during installation. Continue with Installing Cisco VNDS (Windows), page 3-6. 

The Database Account User Name in Table A-1 on page A-14 is the account used 
by VNDS to access network data stored in the database. This account is created 
after VNDS is installed using the user name and password entered during VNDS 
installation. 
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Warning DO NOT use SYS or SYSTEM for the Database Account User Name.

Installing Oracle TopLink (Windows)
The Cisco VNDS program requires access to an installation of Oracle 9i 
Application Server Toplink that is patched to release 9.0.3.5. This section 
describes how to install Toplink 9.0.3.5 on your system. Install Toplink on the 
same system as Cisco Virtual Network Data Server. 

Table A-1 Database Access Information Worksheet

Access Item Value Description

Database TNS Service Name 
(alias for Database GDN)

• The TNS Net Service name used for the local or 
remote database. Refer to Locating a Database 
Net Service Name in tnsnames.ora (Windows), 
page A-16 in the Appendix for instructions on 
locating the service name.

Database SID • The database SID. 

Database hostname • The IP address or fully qualified domain name for 
the database host. Only needed for remote 
databases. 

Oracle Home (installation) 
directory 

• The Oracle installation directory on the database 
host. Only needed for remote databases. 

Oracle Oradata Parent directory • The parent directory to the Oracle oradata 
directory on the database host. Only needed for 
remote databases. 

Database account user name • User name of the account used to access the 
database. DO NOT use the Oracle SYS or 
SYSTEM accounts. 

Database account password • Password for the account used to access the 
database. 
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Note VND Server requires access to Oracle TopLink 9.0.3.5. This is true regardless of 
the version of Oracle used for the VNDS database.

Note You must perform the following procedure before you install 
Cisco Virtual Network Data Server. 

Installing Toplink 9.0.3.5 (Windows)

Step 1 Download or copy the required Oracle Toplink components into a working 
directory: 

• Oracle Toplink 9.0.3.0 (A99417-01.zip) 

• Oracle Toplink 9.0.3.5 patch (p3188702_9031_GENERIC.zip)

Step 2 Create a working directory on your system. Copy the downloaded Oracle Toplink 
9.0.3.0 and 9.0.3.5 zip files to this directory.

Step 3 Unzip the Oracle Toplink 9.0.3.0 archive, A99417-01.zip, into the working 
directory. 

Step 4 Execute the Toplink 9.0.3.0 installer, toplink903-windows.exe:

a. At the introduction panel, click Next. The installer prompts you for the 
installation folder. 

Note If you already have an Oracle installation on this system, the default 
Toplink installation folder will be in your Oracle installation. Cisco 
recommends that you use this folder. Write down the installation folder 
you choose; you will need it later during installation of 
Cisco Virtual Network Data Server. 

b. Select an install folder and click Next. In the remaining panels, the installer 
prompts you for:

– Shortcut Location (select your preference)

– Toplink Features (select Full Install) 

– Viewing Release Notes (select your preference) 
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c. Work through the remaining installer panels and enter the preferences in Step 
b. Click Done in the Install of TopLink Complete panel to exit the installer. 

Step 5 Do the following steps to install the Toplink 9.0.3.5 patch. 

a. Open a window to the working directory that contains the Toplink patch, 
p3188702_9031_GENERIC.zip. 

b. Unzip the Oracle Toplink patch archive, p3188702_9031_GENERIC.zip, into 
the Toplink installation directory. For example, if you installed Toplink to 
C:\oracle\ora92\toplink, select this path as the extraction path for the archive. 

c. If you are prompted to confirm file overwrite, select "Yes to All".

d. Close the archive application (WinZip or similar application) when done. 

e. Verify that the Toplink installation has the files required by 
Cisco Virtual Network Data Server. The following files should exist in the 
<toplink install>\core\lib directory: 

– tl_core.jar

– tl_tools.jar

– tl_x.jar 

At this point, Toplink 9.0.3.5 is installed on your system and ready for access 
during Cisco Virtual Network Data Server installation. Proceed to the next step of 
the installation workflow (as described in Installation Workflows, page 3-2).

Locating a Database Net Service Name in 
tnsnames.ora (Windows)

VNDS uses a database’s Oracle Net service name for connection to the database. 
This is true whether VNDS uses a local or remote database. The database service 
name is located in the tnsnames.ora file. This file is located in the <oracle 
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install dir>\ora92\network\Admin for Oracle9i and at <oracle install 
dir>\product\10.2.0\db_1\NETWORK\ADMIN directory for Oracle10g. A sample 
file is shown below. 

In this sample file, there are three entries. The O92AML14.OPNET.COM entry 
(highlighted) represents the database service name. Each entry has a <net 
service name> = () structure. The text string preceding the “=” is the service 
name. In this example, you use O92AML14.OPNET.COM as the service name for 
VNDS installation. 

Note that this file has entries for other Oracle Net services and may contain entries 
for more than one database. If the Oracle installation you are using supports other 
products, contact the database administrator for the service name you should use. 

# TNSNAMES.ORA Network Configuration File: 
D:\oracle\ora92\network\admin\tnsnames.ora
# Generated by Oracle configuration tools.

O92AML14.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = o92aml14)
    )
  )

EXTPROC_CONNECTION_DATA.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC0))
    )
    (CONNECT_DATA =
      (SID = PLSExtProc)
      (PRESENTATION = RO)
    )
  )

INST1_HTTP.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVER = SHARED)
      (SERVICE_NAME = o92aml14)
      (PRESENTATION = http://admin)
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A P P E N D I X B
Oracle Procedures (Linux)

This appendix includes a set of procedures for installing Oracle software for use 
with Cisco Virtual Network Data Server. For information about when to perform 
each procedure, see the “Installation Workflows: Overview” section on page 4-2.

Note The instructions in this appendix are included for the convenience of Cisco VNDS 
users. For detailed information about using Oracle products, consult the Oracle 
product documentation or Oracle technical support.

Oracle Installation Procedures
The procedures for installing Oracle on Linux can vary, depending on the versions 
of Oracle and Linux as well as platform-specific parameters. Installing Oracle 
might also require changes in kernel settings, updating system patches, and other 
system administration tasks. Work with your Database Administrator and refer to 
the Oracle Installation Guide and other relevant Oracle documentation to 
complete the installation. 

Note Check the /etc/oratab file and verify that the database instance you are using 
can be started by Oracle scripts. The oratab entry for the database instance name 
you are using should end in “:Y”. If it does not, work with your database 
administrator to change this setting to allow database startup.
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Configuring the Environment for the oracle Account (Linux)

Step 1 Verify/configure the environment for the oracle account.

a. Open /oracle/.bash_profile with a text editor of your choice. 

Note If you are using another shell, examine the appropriate file.

b. Confirm that it has the following entries. Manually add the entries, if needed. 

ORACLE_HOME=<oracle_home>
ORACLE_SID=<dbSID>
PATH=$ORACLE_HOME/bin:$PATH
export PATH
export ORACLE_HOME ORACLE_SID

where <dbSID> is the database SID (for example, o92ml23) 
and <oracle_home> is the Oracle installation directory (for example, 
/u01/app/oracle/product/9.2.0)

Configuring Permissions for Oracle Directories (Linux)

Step 1 Assign read and execute permissions for all users to the bin, lib and jdbc 
directories in $ORACLE_HOME.

a. Log in as oracle.

b. Use the following commands to modify directory permissions.

chmod 755 $ORACLE_HOME/bin
chmod 755 $ORACLE_HOME/lib
chmod 755 $ORACLE_HOME/jdbc
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Collecting Oracle Database Access Information 
(Linux)

The VNDS installer prompts for database access information. Before beginning 
installation, collect the database access information listed in Table B-1. The 
database administrator can supply the database access information that you need. 
Print out the installation instructions and write down the database access 
information in the Table B-1 for reference during installation. Continue with 
installing Cisco VNDS. 

The Database Account User Name in Table B-1 is the account used by VNDS to 
access network data stored in the database. This account is created after VNDS is 
installed using the user name and password entered during VNDS installation. 

Warning DO NOT use SYS or SYSTEM for the Database Account User Name.

Table B-1 Database Access Information Worksheet

Access Item Value Description

Database TNS Service Name 
(alias for Database GDN)

The TNS Net Service name used for the local or 
remote database. Refer to Locating a Database 
Net Service Name in tnsnames.ora (Linux), 
page B-6 in the Appendix for instructions on 
locating the service name.

Database SID The database SID. 

Database hostname The IP address or fully qualified domain name for 
the database host. 

Oracle Home (installation) 
directory 

The Oracle installation directory on the database 
host.

Oracle Oradata Parent directory The parent directory to the Oracle oradata 
directory on the database host.
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Installing Oracle TopLink (Linux)
The VNDS program requires access to an installation of Oracle 9i Application 
Server Toplink that is patched to release 9.0.3.5. This section describes how to 
install Toplink 9.0.3.5 on your system. Install Toplink on the same system as 
Cisco Virtual Network Data Server. 

Note VND Server requires access to Oracle TopLink 9.0.3.5. This is true regardless of 
the version of Oracle used for the VNDS database.

Note You must perform the following procedure before you install 
Cisco Virtual Network Data Server. 

Installing Toplink 9.0.3.5 (Linux)

Step 1 Log into your system using the account used to operate Cisco VNDS. 

Step 2 Download or copy the required Oracle Toplink components into a working 
directory: 

• Oracle Toplink 9.0.3.0 (A99417-01.zip) 

• Oracle Toplink 9.0.3.5 patch (p3188702_9031_GENERIC.zip)

Step 3 Create a working directory on your system. Copy the downloaded Oracle Toplink 
9.0.3.0 and 9.0.3.5 zip files to this directory.

Database account user name User name of the account used to access the 
database. DO NOT use the Oracle SYS or 
SYSTEM accounts. 

Database account password Password for the account used to access the 
database. 

Table B-1 Database Access Information Worksheet (continued)

Access Item Value Description
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Appendix B       Oracle Procedures (Linux)
    Installing Oracle TopLink (Linux)

Step 4 Unzip the Oracle Toplink 9.0.3.0 archive into the working directory. To do this, 
enter the following command:

unzip -d <working_dir> <zip_file> 

Step 5 Use the gzip command to expand the GZ file. To do this, enter the following 
command:

gunzip toplink903-unix.tar.gz 

Step 6 Use the tar command to expand the TAR file. To do this, enter the following 
command: 

tar -xvf toplink903-unix.tar 

This command creates a toplink directory under the working directory. 

Step 7 Do the following steps to install the Toplink 9.0.3.5 patch. 

a. Open a window to the working directory that contains the Toplink patch, 
p3188702_9031_GENERIC.zip. 

b. Unzip the Oracle Toplink patch archive, p3188702_9031_GENERIC.zip, into 
the Toplink installation directory. To do this, enter the following command:

unzip -d <working dir>/toplink p3188702_9031_GENERIC.zip 

For example, if you installed Toplink to /uo1/app/oracle/9.2.0/toplink, 
select this path as the extraction path for the archive. 

c. If you are prompted to confirm file overwrite, select [A] for "Yes to All".

d. Verify that the Toplink installation has the files required by 
Cisco Virtual Network Data Server. The following files should exist in the 
<toplink install>/core/lib directory: 

– tl_core.jar

– tl_tools.jar

– tl_x.jar 

At this point, Toplink 9.0.3.5 is installed on your system and ready for access 
during Cisco Virtual Network Data Server installation. Proceed to the next step of 
the installation workflow (as described in Installation Workflows, page 3-2).
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Locating a Database Net Service Name in 
tnsnames.ora (Linux)

VNDS uses a database’s Oracle Net service name for connection to the database. 
This is true whether VNDS uses a local or remote database. The database service 
name is located in the tnsnames.ora file. This file is located in the following 
directory:

Oracle 9i: <oracle install dir>/oracle/product/9.2.0/network/Admin 

Oracle10g: <oracle install dir>/oracle/product/10.2.0/NETWORK/ADMIN 

In the following example file, there are three entries. The O92AML14.OPNET.COM 
entry (highlighted) represents the database service name. Each entry has a <net 
service name> = () structure. The text string preceding the “=” is the service 
name. In this example, you use O92AML14.OPNET.COM as the service name for 
VNDS installation. 

Note that this file has entries for other Oracle Net services and may contain entries 
for more than one database. If the Oracle installation you are using supports other 
products, contact the database administrator for the service name you should use.

# TNSNAMES.ORA Network Configuration File: 
/uo1/app/oracle/product/10.2.0/network/admin/tnsnames.ora 
# Generated by Oracle configuration tools.

O92AML14.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = o92aml14)
    )
  )

EXTPROC_CONNECTION_DATA.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC0))
    )
    (CONNECT_DATA =
      (SID = PLSExtProc)
      (PRESENTATION = RO)
    )
  )



B-7
Installation Guide for Cisco Virtual Network Data Server

OL-11599-01

Appendix B       Oracle Procedures (Linux)
    Locating a Database Net Service Name in tnsnames.ora (Linux)

INST1_HTTP.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVER = SHARED)
      (SERVICE_NAME = o92aml14)
      (PRESENTATION = http://admin)
    )
  )
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A P P E N D I X C
Errata

This appendix contains miscellaneous information that was unavailable when the 
Cisco VNDS documentation was published.

Additional Requirements for the “Cisco WAN 
Manager” Adapter

The Cisco WAN Manager adapter includes a CWM Database Reader option. To 
use this option, you must perform the following procedure. 

For more information about the Cisco WAN Manager adapter, see the following 
section of the Cisco Virtual Network Data Server documentation:

VNE Server User Guide > Importing Device and Configuration and Topology 
> Cisco WAN Manager Import

Installing Additional Libraries to Allow Communication with the Cisco WAN Manager Database

Step 1 Obtain and install the IBM Informix JDBC Driver libraries.

For information about purchasing the IBM Informix JDBC Driver, go to:

http://www.ibm.com/software/data/informix/tools/jdbc 

For information about downloading an evaluation or trial version of the IBM 
Informix JDBC Driver, go to :

http://www.ibm.com/software/data/informix/downloads.html 

http://www.ibm.com/software/data/informix/tools/jdbc
http://www.ibm.com/software/data/informix/downloads.html
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Note You must install IBM Informix JDBC Driver version 2.21.JC4 or later. 

Step 2 After you obtain and successfully install the IBM Informix JDBC driver, you must 
copy or link all files located in

<Informix_JDBC_Driver_Install_Directory>/lib 

to the following directory:

<Cisco_VNDS_Install_Directory>/ext 

Note All files in the <Informix_JDBC_Driver_Install_Directory>/lib 
directory should have a prefix of “ifx” and a suffix of “.jar”.

Step 3 Restart Cisco VNDS services.
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A P P E N D I X D
Known Issues

We highly recommend that you check, after installation and on a regular basis, for 
software updates and maintenance information of any software, documentation, 
model, or other components on http://www.cisco.com/techsupport.

You can search for additional online information regarding known product issues 
and workarounds on the Cisco Quick Support page at OPNET Technologies 
(http://www.opnet.com/support/cisco_qsp.html).

http://www.cisco.com/techsupport
http://www.opnet.com/support/cisco_qsp.html)
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